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Executive Summary 

The Mill River Greenway is a proposed multipurpose pathway between the towns of Ashfield, 

MA and Northampton, MA along the Mill River, a tributary of the Connecticut River. The 

proposed Mill River Greenway at the Route 9 bend (hereafter referred to as the Bend) between 

Williamsburg and Haydenville is at risk of bank erosion. To address this concern, our Design 

Clinic team has collaborated with the Williamsburg Mill River Greenway Committee (WMRGC) 

this academic year to provide them with a recommendation for river bank-protection at the Bend 

and adjacent banks. 

 

This report defines the twofold scope of our collaboration with WMRGC. First, it expands on the 

hydraulic model created by the team to assess two factors: a) The existing conditions of the river 

at the project site and b) the hydraulic effects of both implementing the considered bank-

protection designs and of decommissioning the Brassworks Dam. To create these models, we 

collected bathymetric data in two main groups, the first defining the Bend area and the second 

defining the post-dam area. This data then fed into the base model simulating existing conditions. 

To understand the hydraulic effect of removing the dam, we simulated the dam as an inline 

structure for existing conditions and removed the structure to simulate the dam removal. 

Additionally, the team modelled the effect of bank-protection structures on channel location by 

shifting the channel by the same amount of structure intrusion into the river at bank-full.   

  

Second, this report presents and discusses design selection criteria for bank-protection along 

different sections of the reach and presents WMRGC with our resulting recommendations for 

bank-protection. To achieve this, we divided the river reach at the Bend into three zones, each 

characterized by a range of velocities and bank slopes. We then identified the bank-protection 

components needed in each zone and a list of alternatives that would meet those needs. We then 

narrowed down the combinations into two optimum designs for each zone using the appropriate 

combination of these alternatives as guided by our criteria and the zone needs. 

  

To test the validity of the optimum designs, we integrated them into the hydraulic base model 

and compared the resulting velocities with the allowable velocities of these alternatives. This 
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integration resulted in a total ofsix variations of the model covering existing conditions and 

considered bank-protection designs both with and without the Brassworks Dam. 

  

Accordingly, we determined live staking and stream barbs to be most effective to redirect and 

reduce the high flows upstream of the Bend. Directly at the Bend and immediately downstream, 

we recommend a concrete vertical wall armored by riprap to shield the particularly high 

velocities and support the steep slope. 
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I. Introduction & Project Overview  

Williamsburg is a town in Hampshire County, Massachusetts, United States (Figure 1) 

that stretches over an area of 25.7 square miles. In addition to the main village of 

Williamsburg near the center of town, the town includes another village center, 

Haydenville. The Mill River flows southeast from Williamsburg village, where the East 

and West branches join, through Haydenville and eventually into the Connecticut River.  

 

Figure 1. Town of Williamsburg (Red) and Hampshire County (Pink) in the State of 

Massachusetts 

 

The Williamsburg Mill River Greenway Committee (WMRGC) - a subcommittee within 

the greater Mill River Greenway Initiative - focuses on creating a multi-use path that 

stretches along the 2.1 mile corridor connecting the villages of Williamsburg and 

Haydenville along Route 9 (Figure 2). 
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    Figure 2. Path of Proposed Greenway 

 

 

Along the Greenway’s proposed path is a bend (hereafter referred to as the Bend) located 

between the Williamsburg Snack Bar and the Brassworks Building (Figure 3). The location 

and constraints posed by the road and slope of the Bend puts the proposed Greenway’s bank 

at risk of erosion from the Mill River. 
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Figure 3. Aerial View of the Bend between the Snack Bar and the Brassworks Building 

 

The scope of our project centers around creating a hydraulic model of the Mill River between the 

Williamsburg Snack Bar and the South Main St. Bridge. We started by modeling the existing 

conditions at our site, and then added bank protection designs intended to prevent future erosion 

from occurring. In our models, we also accounted for the Brassworks Dam, which is located 

midway between the Bend and the bridge. This dam has already been significantly deteriorated 

due to recent large storms. Whether it is a result of purposeful action by the town or of future 

storms, the dam will be rendered completely ineffective at some point. We accounted for this by 

running each of our models with and without the dam present. (Figure 4) 
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Figure 4. Diagram of Project Scope 

 

Based on the results from our base model of existing conditions, we separated our preliminary 

designs into three regional zones according to their flow conditions and slopes at the bank. 

We then tested our preliminary bank protection designs in the model, and based on those outputs 

determined which designs were viable (Figure 4). 

 

Our team’s involvement with the project concluded in May of 2018, and construction by 

MassDOT is not expected to start for approximately 8 more years; therefore, we will not be 

involved in that part of the operation. This timeline does, however, allow for our work to feed 

into the design development study to be performed by the engineering firm contracted by the 

Town of Williamsburg, VHB. Our hydraulic model is of particular value to the upcoming project 

milestones, as it is expected to feed into the design work carried out by VHB.  

 

Our team collaborated with members of WMRGC and other highly qualified 

community members, including Nick Dines, member of WMRGC and Professor Emeritus of 

UMass Landscape Architecture and Planning; Carl Gustafson, retired USDA Natural Resources 

Conservation Service Engineer; Jim Hyslip, member of WMRGC and Principal Engineer at 

HyGround Engineering; Gaby Immerman, chair of the WMRGC and Landscape & Education 
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Specialist with the Smith College Botanic Garden; and Brett Towler, Hydraulic Engineer and 

Fish Passage Engineer with the U.S. Fish & Wildlife Service. 

 

II. Background and Motivation 

In October of 2009, a group of local residents from the towns of Northampton and Williamsburg 

formed a group focused on exploring and reviving the ecological, cultural, economic, and 

recreational value of the Mill River. This group has since expanded to include residents from all 

nine towns along the Mill River and launched several projects, most recently the Williamsburg-

Haydenville Mill River Greenway Project. This project aims to provide a shared use path for 

pedestrian and bicycle connections between the two town centers, as well as a connection to the 

Mass Central Trail at the Haydenville/Northampton Town Line in order to enhance walkability 

within the community (Mill River Greenway Mission Statement, 2017). Figure 5 displays a cross 

section schematic of the proposed design, and Figure 6 shows a sketch of the design. 

Figure 5. Cross-section of Greenway and Roadway (Dines, 2017) 
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Figure 6. Sketch of Proposed Greenway at the Bend (Dines, 2017) 

 

 

The process began in 2013 with a feasibility study (Dodson & Flinker, 2015), followed by the 

development of various route options over the next year. A single route was selected in 2016, 

and a Project Need Form was submitted. 

 

In March 2017, the Massachusetts Department of Transportation (MassDOT) declared 

WMRGC’s proposal eligible for state and federal transportation funding. As of October, the firm 

VHB has been selected to complete initial route survey work. VHB hired a subcontractor, Hill 

Engineers, who started their survey in late fall. In addition, VHB will produce a pre-construction 

design development study. The estimated construction start date is scheduled for approximately 

2025. Because the Greenway is in its early stages, our work on this project fundamentally 

contributes to future work.  

 

The Greenway project has several complex components, including its landscape design, roadway 

retaining walls, and several pedestrian bridges. Our project is the interface between the 
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Greenway and the Mill River, where Route 9 bends between the Williamsburg Snack Bar and the 

Brassworks Building. This location is of particular concern to the Greenway project, given that it 

is at risk of erosion by the river (Figure 7). This erosion could completely undermine the project 

if not addressed. 

 

 

Figure 7. The Bend towards Snack Bar 

 

As mentioned previously, another key component for this section of the greenway is the 

Brassworks Dam. The dam has been significantly damaged in recent years due to major 

hurricanes Irene (2011) and Sandy (2012). It is inevitable that the dam will eventually be 

rendered completely ineffective, whether it is a result of future natural disasters or of a decision 

on the town’s part to remove it in a planned procedure. It is therefore a useful practice to model 

how the dam’s absence will impact stream conditions. 

 

Our project provides the Williamsburg Greenway Committee with a robust HEC-RAS model of 

the Mill River river-reach from the Route 9 bend to the South Main St. Bridge both with and 

without the Brassworks dam. This model will be used by the company VHB in their design 

work. In addition, we are providing a design set of feasible bank protection alternatives along the 

Bend area, considering both traditional and bioengineered methods. We started with the client-
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preferred concrete retaining wall, and decided to also investigate bioengineered alternatives in 

order to produce a holistic set of options.  

 

III. Site Documentation through GIS 

Our team began by familiarizing ourselves with the project landscape, and formulating a 

common understanding through our initial site visit, input from liaisons, and background 

research about the Greenway Initiative, history of the area, and the significance of the Mill River 

to the local community. Additionally, we documented relevant site characteristics in the form of 

annotated GIS maps. These maps allowed us to document important features of our site that will 

likely influence decision making regarding the Greenway. All maps can be found in Appendix 1. 

Table 1 summarizes the list of relevant layers, each accompanied by its method of acquisition 

and a brief description. 

 

Table 1. GIS Layers with Corresponding Sources 

GIS Layer Source Description 

Orthography Professor Reid Bertone-Johnson’s database, 

Landscape Studies Department, Smith College 

Satellite imagery 

Topography Professor Reid Bertone-Johnson’s database, 

Landscape Studies Department, Smith College 

2 ft contour lines containing 

information on elevations 

Mill River 

Polygon 

Professor Reid Bertone-Johnson’s database, 

Landscape Studies Department, Smith College 

Visual representation of 

river 

Roads MassGIS Data: MassDOT roads Route 9 

Wetlands Dodson & Flinker  Valley View Farm wetland 

delineation 

Soils MassGIS NRCS SSURGO-Certified Soils 

(Last updated 11/2012) 

 

Soil composition 

Land use  MassGIS Data: Land Use (Last updated 2005) Example residential, 

wetlands, farmland, etc. 
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This information is especially critical in the case of retainment options that would cause a 

dramatic shift of the river channel. For example, the land on the South bank of the river is 

privately owned by Valley View Farms. If the river shifts, it will encroach on their land and 

WMRGC may wish to consult with the land owners about this prospect. 

 

 

IV. Hydraulic Model 

To better understand the hydraulic conditions of the river, assess the hydraulic effects of 

integrating certain bank protection designs, and understand the effect of decommissioning the 

Brassworks Dam, our team developed a hydraulic model of the Mill River. The function of the 

hydraulic model is to assist WMRGC in making more technically informed decisions. Using the 

different variations of this model, WMRGC may better understand the existing conditions of the 

river and the influence of considered bank protection designs on the river velocities and water 

surface levels. These models also simulate the effect of eliminating the Brassworks Dam. 

Understanding the role of the Brassworks Dam on the river velocities and water surface levels at 

the Bend can help WMRGC decide whether the dam removal will improve upstream hydraulic 

conditions. The model covers the reach extending between the Williamsburg Snack Bar on the 

upstream end and 30m downstream of the South Main St. Bridge on the downstream end, as seen 

in Figure 8 below. 

 
Figure 8. Aerial View Showing the Spatial Extents of our Hydraulic Model 
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Sections 4.1 through 4.7 below list the design requirements of these models, give background 

information about the program we chose for our modeling purposes, explain the process of their 

creation, and elaborate on their different versions.  

 

4.1 Design Requirements for Hydraulic Model 

We identified a number of design requirements to guide the development of the hydraulic model 

(Appendix 2). First, the model must be compatible with the industry standard for river modeling 

software, in this case HEC-RAS 1D, as confirmed by Brett Towler. The model must be run for 

the 2, 5, 10, 25, 50, and 100 year floods as guided by MassDOT standards and our client. The 

model must accurately predict water surface levels within 1ft of error, as advised by Brett 

Towler. Additionally, the model must allow for the quantification of the effect of the Brassworks 

Dam removal, and must thus include a version without the dam. Finally, the model must be 

compatible with future surveys of the project site. In particular, Hill Engineers should be able to 

locate the model’s control points in their future surveys. 

 

 

4.2 Introduction to HEC-RAS 

We created the hydraulic model using the Hydrologic Engineering Center River Analysis System 

(HEC-RAS). HEC-RAS is an open source software developed by the Army Corps of Engineers 

and is widely used in the industry for river modeling purposes (Hydrologic Engineering Center, 

2017). HEC-RAS allows for both 1D and 2D modeling, where 1D analysis uses river cross-

sections as base-units for flow analysis while 2D uses grid or mesh based units for this purpose. 

1D is sufficient for the analysis of primarily unidirectional flowing rivers where minimal 

splitting takes place, while 2D is more appropriate for shallow and splitting flows. For this 

reason, we have determined under the guidance of Brett Towler and Carl Gustafson that 1D 

modeling is sufficient for the purposes of our project. 

 

HEC-RAS employs the one-dimensional energy equation as a basic computational procedure for 

steady flow analysis. Energy losses are accounted for through contraction / expansion and 



11 

surface roughness frictional losses. The latter are specified through Manning’s roughness 

coefficient, while expansion / contraction are specified through their corresponding coefficients. 

 

In broad terms, the creation of a 1D steady-flow analysis in HEC-RAS requires the user to define 

an appropriate number of cross-sections in the studied reach, specify the downstream reach 

distance separating each cross-section from the consecutive one, define the extent of the left and 

right banks of each of the cross-sections, and specify the roughness of the banks and main 

channel. Additionally, the user has to feed into HEC-RAS the flow on which the analysis is to be 

performed. A detailed manual on how to create a steady flow model in HEC-RAS can be found 

in Appendix 3.   

 

4.3 Spatial Scope of the Hydraulic Model 

The hydraulic model covers the reach extending between just before the Williamsburg Snack Bar 

on the upstream end and 30m downstream of South Main Street Bridge on the downstream end, 

as seen in Figure 8 above. The choice of this reach was informed by two main factors: 

 The presence of the Bend area, which constitutes our main area of concern in this 

project.  

 The presence of the South Main St. Bridge in the reach, which allows for modeling the 

removal of the Brassworks Dam, since the bridge acts as the first major constriction 

downstream of the dam.  

 

4.4 Model Development: Existing Conditions 

The first step in developing our base model was collecting its input data (Figure 9). We surveyed 

the river’s bathymetry in two main stages; the first covered the bend area and the second covered 

the area downstream of the Brassworks Dam. The first data set, which we collected during the 

fall, included seven cross-sections (XS13 through XS7).  
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Figure 9. Aerial View (Google Maps) Showing the Two Groups of Cross Sections Surveyed: 

The First Defining the Bend Area and the Second Defining the Reach between the Dam and 

the Bridge. 

 

Our choice of cross-section location in this first collection area was influenced by river 

accessibility and the need to capture important features of the Bend area (Figure 10). 

 

Figure 10. Labeled Section Diagram of River Features for Surveying (Brett Towler, 2017) 
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The second data set, which we completed in the winter, included three cross-sections 

downstream of the Brassworks Dam (XS4, XS2, XS1). The goal of surveying this reach was 

to allow for the omission of the dam in our model. For this purpose, we surveyed a cross-

section midway between the dam and South Main St. Bridge (XS4) - with the purpose of 

characterizing the geometry of the channel connecting the dam with the bridge -  and two 

cross-sections defining the bridge constriction (XS2 and XS1).  

 

In addition to the above-surveyed cross-sections, we created four additional cross-sections 

using interpolation and photographic representation of XS6, XS5, XS3, and XS0. This 

amounted to a total of 14 cross sections that were refined to reduce error and used to create 

our base model. The creation and refinement of these cross-sections are fully detailed in 

Appendix 4. 

 

The Brassworks Dam was modeled as an inline structure. We used current photos of the dam 

to define the shape of this inline structure in HEC-RAS (Figure 11). 

 

Figure 11. Photo of Brassworks Dam (Left) and HEC-RAS Screenshot Showing the 

Brassworks Dam Modeled as an Inline Structure (Right) 

 

To have our model accommodate higher water levels during river flooding, we extended each 

cross-section by 25-30ft on both the right and left banks. Most of the cross-sections either 

extended to a road or flat field, in which case we assumed horizontal lines as extensions 

(Figure 12). In some other cases where the cross-section extended to a slope, we used a 2 ft 
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contour GIS layer and site visit pictures to estimate the slope and extend the cross-section 

accordingly (Figure 13).  

  

Figure 12. XS 12 with Flat Extensions: Flat Field on the Right of Bank and Route 9 on the 

Left of Bank 

 

Figure 13. XS 0 with Sloped Extensions on Left and Right 



15 

 

We developed flow values used in the models using a Log-Pearson Analysis (Appendix 5) 

with input data from the Northampton USGS Gauge Station (USGS-01171500) prorated 

down to our site. We used the ratio of the Williamsburg watershed area at the Bend to the 

Northampton watershed at the USGS as shown in Equation 1: 

    𝑄𝑊𝐵 = 𝑄𝑁𝑜ℎ𝑜(
𝐴𝑊𝐵

𝐴𝑁𝑜ℎ𝑜
)    Equation 1 

where 𝑄𝑊𝐵 is the approximated flow at the Williamsburg site, 𝑄𝑁𝑜ℎ𝑜is the Northampton 

USGS flow, 𝐴𝑊𝐵 and 𝐴𝑁𝑜ℎ𝑜 are the watershed areas of Williamsburg and Northampton 

respectively found through the USGS tool StreamStats (USGS, 2017).  

 

To calibrate our model, one of our technical liaisons, Brett Towler, measured the water 

surface elevation of the river at the South Main St. Bridge and recorded the flow, prorated 

down from the Northampton gauge station as mentioned earlier. We then ran a HEC-RAS 

steady flow analysis of our model using the flow value recorded for the measurement time, 

and recorded the output for water surface level at the bridge. We then calculated the 

difference between the measured and the model-predicted water surface levels at the 

recorded flow.  

 

The above process was repeated for five different flows ranging between 135 cfs and 545 cfs, 

and the highest discrepancy recorded was 0.32 ft (Table 2). The accuracy assessment process 

is explained in detail in Appendix 6.  

 

 

Table 2. The Discrepancy between the Measured and Predicted Water Surface Levels at Five 

Different Flows Fell within the Required Margin of 1ft of Error 
Flow 

(cfs) 

Depth Measured 

(ft) 

Depth Predicted 

(HEC-RAS) 

(ft) 

Discrepancy 

(ft) 

243 1.67 1.6 -0.07 

297 1.83 2.1 0.27 

323 1.89 1.7 -0.19 

440 2.17 2.3 0.13 

979 3.18 3.5 0.32 
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4.5 Verification of Design Requirements 

Once our model was complete, we verified its design requirements as follows.  

 

DR-01: The hydraulic modeling software used by the team is common throughout the 

professional field 

Through our use of HEC-RAS 1D, we have guaranteed that we are employing a widely used 

software.  

 

DR-02: The hydraulic model accounts for the 2, 10, 25, 50, and 100 year floods.   

As seen in Figure 13 below, we have completed the steady flow analysis for the five flow 

values mentioned above. As mentioned earlier, we derived the flow (cfs) of these floods 

using a Log-Pearson analysis (Appendix 5). 

 

 

Figure 14. Screenshot from HEC-RAS Showing Flows of the 2, 10, 25, 50, 100 year floods 

 

DR-03: Predicted values for water surface level must coincide with measured values by 

a margin of error of no more than 1ft.   

Table 2 above confirms that for the five measurements taken at the Bridge for water surface 

level, the discrepancy between measured and model-predicted values never exceeded 0.32ft.  
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DR-04: The model must allow for the quantification of the effect of decommissioning 

the Brassworks Dam 

Our modeling of the Brassworks Dam as an inline structure (Figure 14) allows us to model 

the river reach in the absence of the dam by simply removing the inline structure.  

 

DR-05: Fixed points must be created and must be GPS-located along Route 9 and be 

clearly marked for visual recognition by on-ground surveying crew.  

Our team has defined three control points along the Bend. We have located them on the 

guardrail of cross sections 12, 10, and 8. We have sprayed them and shared their GPS 

locations (Table 3) with Tim Armstrong, the project surveyor from Hill Engineers. Their 

location, along with photos locating them, is documented in detail in the Site Visit 11 

Summary (Appendix 7).  

 

Table 3. The GPS Location of the Three Control Points Along the Bend, Taken Using a 

Trimble GeoXH 2005 Series Pocket PC Set to Massachusetts State Plane Coordinate System. 

  
Northing Easting Elevation 

XS 8 - CP 903982 100611.9 137.5 

XS 10 - CP 904041.65 100572.95 136.4 

XS 12 - CP 904079.4 100494.54 137.6 

 

 

4.6 Model Development: Future Conditions 

This base model was later adjusted to account for bank protection structure integration, 

consequent channel movement, and dam removal. After identifying the length and width 

dimensions of each of the considered bank protection designs elaborated on in the following 

section (Section 5), we measured their distance of intrusion into the water at full bank 

conditions, modeled as the 2-year flood in HEC-RAS. An example of such a measurement 

can be seen in Figure 15 below. 
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Figure 15. A 17ft Road Extension Intrudes a Total Distance of 10.24ft into the River at XS7 

(Top) and the Riverbed is Shifted 10.24 away from Route 9 (Bottom) 

 

We then shifted each cross-section away from Route 9 by the same distance of intrusion, also 

seen in Figure 15. Accordingly, cross-sections that did not include bank protection designs 

were not adjusted.  

 

The Brassworks Dam was modeled using an inline structure. The cross-section adjacently 

upstream to the dam (XS6) was recreated to avoid counting the sediment as bathymetry. We 

simulated the possible removal of the dam by removing the inline structure. The process of 

modeling the dam area is explained in detail in Appendix 8.  

 

We simulated 5 potential future conditions with the following models: 

 

1. A model of the existing conditions of the river, without the Brassworks Dam 

2. A model with a retaining wall bank protection at the bend, with the Brassworks Dam 
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3. A model with a retaining wall bank protection design at the bend, without the 

Brassworks Dam 

4. A model with the considered bioengineered bank protection designs implemented at 

each of their corresponding zones, with the Brassworks Dam 

5. A model with the considered bioengineered bank protection designs implemented at 

each of their corresponding zones, without the Brassworks Dam 

 

4.7 Hydraulic Effect of Dam Removal 

We compared the velocities and water surface elevations of the two models of the existing 

conditions both with and without the dam. This comparison was done for the 2, 10, 25, 50, 

and 100 year floods. The comparison shows that the removal of the dam has detectable 

effects only on XS8 through XS5, but not on the remaining cross-sections.  

 

Generally, the removal of the dam decreases water surface levels and increases velocities 

upstream of the dam. These changes, however, are more pronounced near the dam. The 

results for the changes experienced by XS8 through XS5 for the 2 and 100 year floods are 

summarized in Table 4 below. Appendix 9 has these results for the 2, 10, 25, 50, and 100 

year floods. 

 

Table 4. Change of Hydraulic Conditions in XS8 – XS5 Due to Dam Removal 

  Velocity (ft/s) Water Surface Elevation (ft) 

XS Flood 

(year) 

Dam No Dam % 

change 

Dam No 

Dam 

∆𝐸𝑙𝑒𝑣𝑎𝑡𝑖𝑜𝑛 

8 2 6.06 6.13 1.16 431.85 431.79 0.06 

100 8.69 9.23 6.21 434.81 434.45 0.36 

7 2 5.41 5.48 1.29 431.75 431.69 0.06 

100 7.94 8.42 6.05 434.71 434.33 0.38 

6 2 2.16 8.14 276.85 431.58 426.04 5.54 

100 3.79 10.92 188.13 434.44 427.68 6.76 

5 2 4.21 14.6 246.79 424.48 422.94 1.54 

100 4.76 18.49 288.45 426.67 423.59 3.08 
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V. Bank Protection Designs 

The second main goal of our collaboration with WMRGC was recommending bank-

stabilization designs and assessing their hydraulic effect on the river at the studied area. 

Developing the final design set was a two-part process.  First, we developed the designs based 

on our stakeholder design requirements, the existing conditions as given by the HEC-RAS 

model velocities, and knowledge of the land type and bank slope grades from our in-person 

site visits. As mentioned earlier, we researched the client-suggested design of a concrete 

retaining wall, and we also explored bioengineered designs in order to consider a wider range 

of options. Second, we entered the best alternatives from the first process into HEC-RAS and 

assessed their effects on the river geometry and velocities. Additionally, we ensured that the 

resulting velocities and water levels meet the stakeholder design requirements. 

 

5.1 Design Requirements  

We defined several design requirements for the bank protection alternatives, as determined by 

WMRGC and local, state and federal regulatory agencies, as listed in the traceability matrix 

(Appendix 2). A major priority was to stabilize the bank by preventing erosion; this can be 

achieved by ensuring that the alternatives withstand velocities for the 100 year floods both 

with and without the dam. Additionally, the river level should not rise above the Greenway, 

which would result in flooding.   

 

Any recommended alternative must also meet MassDOT vehicular and spatial standards by 

accommodating a minimum 5 ft shoulder and the 12 ft wide Greenway (MassDOT Healthy 

Transportation Policy Directive, 2013). In order to minimize the resulting intrusion into the 

river caused by the extension, the bank protection design should be able to accommodate 

steep slopes (Figure 16). 
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Figure 16. Proposed Solution for Road Extension and Added Greenway (Dines, 2017) 

 

The purpose of the Greenway is in part to facilitate appreciation of nature, so we also added a 

design consideration that the bank protection minimize impact on water temperature and 

allow for vegetation and wildlife habitat. Further research into this consideration would 

involve working with the Massachusetts Department of Environmental Protection. 

 

5.2 Bank Protection Alternatives Research 
We generated an initial list of potential bank protection alternatives based on external 

literature review and input from our liaison Carl Gustafson, a former employee of the NRCS. 

In this research process, we focused exclusively on designs that had precedent. Based on the 

conditions specific to our site and other various constraints, we removed several alternatives 

from consideration in the early stages of our concept selection process. This initial list and our 

rationale for the decision-making process can be found in Appendix 10.  

 

5.3 Existing Conditions 

Before we could further narrow down potential alternatives, we needed to analyze the existing 

conditions in more detail and establish specific selection criteria. We divided the river reach 

into three distinct zones (Figure 17), based on three questions: what is the problem, what is 
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the goal, and what are the needs. We then matched the alternatives with the functions that 

meet those needs to each zone. 

 

 

Figure 17. Zone Boundaries Along the Bend 

 

Zone 1 consists of cross sections 12 and 13; Zone 2 cross sections 9, 10, and 11; and Zone 3 

cross sections 7 and 8 (Figure 9). Zone 1 on its own is not an area of significant concern; there 

is a relatively gentle slope and very little curvature at this point. Additionally, the velocities at 

this zone are relatively low (7.12 – 12.1 ft/s). However, Zone 1 is crucial in serving as a 

preventative measure in anticipation of the high flows in the subsequent downstream sections. 

We chose vegetative alternatives to increase the roughness coefficient and redirective 

alternatives to move the flow away from the river bank. 

 

At Zone 2, the river bank is in the most critical condition due to a combination of steep slopes 

and a nearly 120º bend resulting in high velocities (12.4 -25.8 ft/s). To address these concerns, 

we selected alternatives that provide toe armoring and sustain a vertical slope from the 

riverbed to the road level, in addition to vegetative and redirective components. Zone 3 has 

similarly high flows and even steeper slopes; however, this section is a straight-away so it 

does not require redirective alternatives. 
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5.4 Design Development  

To leverage analysis of the existing conditions (Appendix 11), we created an assessment 

matrix for each zone (Figures 18-20). We generated the 10 criteria used in these matrices first 

by looking at our design requirements and conducting external research, then by consulting 

our liaison Carl Gustafson, who has prior experience on projects using these alternatives. We 

used a stoplight system in formatting the matrix, where green indicates the most favorable 

option; red indicates the least favorable option; and yellow falls in between. Where a certain 

criterion was not applicable to an alternative, we grayed out the cell. It is important to note 

that, although red represents the worst option, we did not rule out alternatives marked as red 

because the criteria had varying weights. 

 

Figure 18. Zone 1 Concepts Assessment Matrix 

 

Figure 19. Zone 2 Concepts Assessment Matrix 
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Figure 20. Zone 3 Concepts Assessment Matrix 

 

Our goal was to create combinations of individual alternatives, which we will refer to as 

designs, for each zone in order to meet each need.  

 

In cases where there were more than one alternative that performed the same function (e.g. 

“Vegetative”), we compared alternatives within their function groups. Where there was only 

a single option for a given function (e.g. riprap in “Toe Armoring”), we included it in each 

zone where the function was needed. We then examined how alternatives from different 

function groups complemented each other; for example, stream barbs pair well with the live 

crib wall because their red blocks are balanced by corresponding green blocks in the other 

(i.e. stream barbs do not provide load acceptance, but live crib walls do) (Appendix 12). 

 

5.5 Modeling Selected Designs in HEC-RAS 

Using the concepts assessment matrices for each zone (Figures 18-20) we selected three 

designs to model in HEC-RAS. For Zone 1, we chose live staking and stream barbs (Figure 

21). For Zones 2 and 3, we modeled two different designs: the first consisted of live crib wall 

with riprap, stream barbs, live staking, and small retaining walls (Figure 22); the second 

consisted of concrete retaining wall with riprap. 
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Figure 21. Examples of Live Staking (left) and Stream Barbs (right) Used for River-Bank 

Restoration. (Cardno, 2018) 

 
 

 

Figure 22. Crib Wall Design for Zone 3 

 

For each of the recommended designs we compared their allowable velocities to those 

predicted by HEC-RAS. Through our research, we found that it is difficult to assign an exact 

number for the allowable velocity of each bioengineered design because these are largely 

determined empirically, and because they are relatively new alternatives with fewer data than 

traditional designs. The NRCS has compiled several of the empirical studies that have been 

completed on bioengineered alternatives, and derived ranges of allowable velocities (Table 5). 

As the vegetation in bioengineered designs has time to grow, the allowable velocities increase. 

For this reason, Table 5 also includes values once the alternative has had time to establish. 
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Table 5. Allowable Velocities for Streambank Soil Bioengineering Practices (NRCS, 2007) 

  

Alternative 
Allowable Velocity - 

Initial (ft/s) 

Allowable  

Velocity -  

Established (ft/s) 

Live Fascine 5 - 8 8 - 10+ 

Wattle Fence 1 - 2.5 3 - 10 

Live Crib Wall 3 - 6 10 - 12 

Brush Layer 2 - 4 10+ 

Live Staking 1 - 2.5 3 – 10 

 

5.5.1 Zone 1 

We did not change the slope of Zone 1 in our design-integrating model since the addition of 

live staking and stream barbs can be implemented with the existing slope. The extension of 

the roadway will require the channel to shift 17 ft towards the south bank to accommodate 

the Greenway and additional shoulder width. This existing slope will be maintained (Figure 

23).  

 

Figure 23. Suggested Shifting of a Cross-Section in Zone 1 

 

Water level elevation and velocity results from HEC-RAS suggest that it is a viable design 

for this zone. At the Route 9 side of the river, the water level predicted by the model for the 

100-year flood is roughly 10 ft below the Route 9 level elevation, so no flooding is expected. 
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Under these conditions, the highest velocity predicted by the model is estimated to be 12.1 

ft/s. The highest velocity that live staking can withstand is 10 ft/s, and the addition of stream 

barbs will reduce velocities, likely making this a suitable velocity tolerance for this zone.  

Although stream barbs were not modeled in HEC-RAS, they are included in this design 

package, as they are the only alternative to address redirective protection. An important 

reason that we did not model stream barbs is that HEC-RAS gives average velocities for a 

given cross-section and does not show local velocities that would result from the addition of 

stream barbs. 

 

5.5.2 Zones 2 & 3 

For each of these two zones, we modeled two designs: a bioengineered and a traditional 

engineering approach.  

 

The bioengineered approach is a combination of live crib wall with riprap, stream barbs, live 

staking, and concrete vertical wall. Note that again, stream barbs were not integrated into our 

model. Constructing a live crib wall for the entire height of the bank is impractical because 

live crib walls have a recommended maximum height of 7 ft (NRCS, 2007). To address this 

constraint, we designed the crib wall to only the 50-year flood height and accounted for the 

remaining elevation using earth slopes with live staking followed by a concrete vertical wall 

(Figure 22).  

 

Modeling the bioengineered design in Zones 2 and 3 for the 100-year flood confirmed that 

these two zones will not experience flooding. On the other hand, the predicted velocities are 

much higher than what this bioengineered design can withstand. The highest velocity that a 

live crib wall can take is approximately 12 ft/s while the highest estimated velocity under 

these conditions is 24.1 ft/s. The highest predicted velocity for the 50-year flood event was 

not very different from 100-year flood. We therefore rejected the bioengineered design for 

Zones 2 and 3. 

 

The traditional design approach for Zones 2 and 3 is a combination of concrete retaining wall 

and riprap. This solution is structurally robust, and it can withstand high velocities. Modeling 
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for the second design confirmed that for the 100-year flood event, flooding on Route 9 is not 

expected. Since a concrete retaining wall in combination with riprap is a retaining solution 

designed specifically for high velocities, we recommend it as a viable design. We also 

recommend the addition of stream barbs to the left bank of Zone 2 to move higher velocities 

away from the bank, a need that is not required for Zone 3 because it is a straightaway. 

 

5.6 Design Verification 

After we finalized the HEC-RAS model for all existing and future conditions, we were able 

to verify whether or not the proposed design alternatives met the design requirements 

established at the beginning of the project (Appendix 13). 

  

DR-01: Alternative must withstand velocities predicted by the HEC-RAS model with 

the dam 

Based on the above comparison between HEC-RAS predicted velocities and allowable 

velocities of our bioengineered alternatives (Section 5.5.1), this design does not appear to be 

able to withstand the maximum velocities predicted by the HEC-RAS model. The remaining 

alternatives, concrete retaining wall and riprap, are able to withstand very high velocities. 

Riprap can withstand approximately a maximum of 26 ft/s and concrete lining approximately 

33 ft/s (NRCS, 2007). 

 

DR-02: Alternative must withstand velocities predicted by the HEC-RAS model without 

the dam 

At the Bend, velocities without the dam proved to be nearly identical to the values calculated 

with the dam present, most likely due to the fact that the dam was already significantly 

deteriorated.  

 

DR-03: River level must not rise above the Greenway bank level 

Looking at the HEC-RAS model visual outputs, we can confirm that the water level does not 

rise above the bank for the 100-yr flood. 
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DR-04: Minimum shoulder width and bikeway width are accommodated 

The concrete wall and riprap design will allow for the minimum 17 ft required for the 

Greenway and shoulder width addition, and we are expecting to move the slope in Zone 1 to 

accommodate this as well. 

 

Considerations 

In addition to our design requirements we added a consideration to minimize the 

environmental impact of the bank protection design. This was a consideration rather than a 

requirement because having the most robust bank alternative to protect against extreme 

events at this point on the route supersedes the environmental concerns. In Zone 1 we do 

meet this consideration with the purely environmental bank protection alternatives. Live 

stakes consist entirely of natural materials, which will eventually root and sprout. They assist 

in quickly reestablishing the riparian vegetation, and over time they add to the roughness of 

the streambank to slow down velocities (NRCS, 2007). The stream barbs push the deeper and 

faster flows away from the bank, leaving a slower velocity area for habitat sustainment. In 

Zones 2 and 3, the retaining wall does have negative environmental impacts (e.g. increases 

water temperatures and velocities, shifts erosive energy downstream, removes existing 

vegetative habitats); methods for mitigating this impact should be further researched. 

 

VI. Final Deliverables 

Revisiting the scope diagram (Figure 24), our deliverables are highlighted by the two 

outlined boxes, one for the hydraulic model and the other for bank protection designs. The 

HEC-RAS model we have provided holds a significant value for future permitting and design 

work. It is easy to modify and so can be used by VHB if they choose to refine certain 

parameters or alter features to reflect their design work. The bank protection alternatives we 

are recommending provide an initial look into what type of alternatives would work 

respective to the critical bend region. Additionally, we are providing documentation of all the 

alternatives that we eliminated and the rationale behind doing so, giving WMRGC insight 

into which alternatives are not viable, and which alternatives should be further developed. 
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Figure 24. Diagram of Project Scope 

 

VII. Next Steps & Future Work 

There is still a significant amount of work to be done before the Greenway is fully 

constructed and ready for use. Our main contributions to the project have been the 

development of a hydraulic model and an initial set of bank protection recommendations. It 

is standard practice to present a hydraulic model to appropriate governmental agencies (i.e. 

U.S. Army Corps of Engineers) for projects constructed near a river. After being reviewed 

internally by engineers working with WMRGC, our model will satisfy this requirement for 

our client. The model’s outputs can be used to predict how any changes or additions to the 

river will affect existing conditions. As previously mentioned, the model is able to be 

modified easily by future collaborators, which may be appropriate given climate change 

uncertainty.  

 

The survey data we collected has inherent error associated with it. While this does not 

significantly impact our hydraulic model, which relies on relative values rather than the 

location of points in space, future collaborators may desire to more precisely locate our 

existing reference points in space. Hill Engineers has tools with far greater accuracy, and 
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they will be able to compare where our points overlap with their survey work on the banks of 

the river. We have provided control points from our survey data set for the purpose of 

connecting these two data sets (Site Visit 11 in Appendix 7). 

 

Our preliminary bank protection design recommendations will need to be reviewed and 

assessed by professional engineers at VHB. Any designs that they move forward with will 

need additional data to inform their implementation. For example, a geotechnical report will 

need to be completed on soils in the area, including borings to determine soil types at various 

depths. Additional soil data can also be used to improve some of our designs; in Zone 1, the 

soil type used for infill can be selected to increase the angle of repose, and thereby decrease 

the design’s intrusion into the river. 

 

Overall, we have provided a solid foundation for WMRGC and their future collaborators on 

which to build over the coming years. Accordingly, we have included extensive 

documentation of our processes and deliverables with this in mind, and expect that this report 

will also support future additions to our work. 

 

VIII. Summary 

This project was part of the bigger Mill River Greenway Project, which is going to create a 

connector between Haydenville and Williamsburg. We worked with WMRGC to aid in 

decision making on protecting the portion of the proposed Greenway along the Bend from 

bank erosion caused by the Mill River. Our scope of work featured an interplay between the 

GIS layer documentation at the site, development of a hydraulic model of the river reach 

upstream and downstream of the Bend, and our proposed design alternatives for bank 

protection. The GIS layer serves the purpose of documenting important features of the site 

that can influence decision making regarding the Greenway or the potential shifting of the 

river. These features include roads, wetlands, soil types, and land use. The HEC-RAS model 

consists of several different configurations: the existing river conditions and our 

recommended bank protection designs both with and without the Brassworks Dam. The bank 

protection deliverable presents our top option for bank protection for the three different zones 
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we defined at the Route 9 bend: stream barbs and live staking in Zone 1, a combination of 

concrete wall, stream barbs, and riprap in Zone 2, and a concrete wall with riprap for Zone 3. 

 

This project is still in its early stages and our work is only one of many components feeding 

into the final design. We look forward to the future development and construction of the 

Greenway over the next decade. 
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Appendix 1 - GIS Documentation

Our GIS documentation consists of five different maps, with a total of 7 layers. 
These maps help us to characterize the soil slopes, topography, farmland types,
boundaries of various land uses, property ownership, and rock types.



SOIL​ ​SLOPE 

This​ ​layer​ ​consists​ ​of​ ​two​ ​overlain​ ​layers: 

Area​ ​by​ ​soil ​ ​slope ​,​ ​sourced​ ​from​ ​MassGIS​ ​NRCS​ ​SSURGO-Certified​ ​Soils​ ​database.​ ​This​ ​layer​ ​divides​ ​the​ ​landscape​ ​into​ ​5​ ​areas​ ​of​ ​varying​ ​slope-ranges​ ​shown 
in​ ​the​ ​legend​ ​below.​ ​(MassGIS,​ ​November​ ​2012) 

2-ft​ ​contour​ ​lines ​,​ ​supplied​ ​by​ ​Reid​ ​Bertone-Johnson,​ ​Smith​ ​College​ ​Landscape​ ​Studies​ ​Department.​ ​Given​ ​its​ ​large​ ​scale,​ ​this​ ​layer​ ​provides​ ​a​ ​more​ ​accurate
characterization ​ ​of​ ​the​ ​landscape.

(MassGIS​ ​November​ ​2012) 
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PRIME​ ​FARMLAND 
This​ ​layer​ ​consists​ ​of​ ​three​ ​farmland​ ​categories:​ ​prime​ ​farmland,​ ​farmland​ ​of​ ​unique​ ​importance,​ ​and​ ​farmland​ ​of​ ​statewide​ ​importance.​ ​The​ ​land​ ​immediately​ ​on 
either​ ​side​ ​of​ ​the​ ​river​ ​is​ ​prime​ ​farmland,​ ​and​ ​as​ ​such​ ​should​ ​be​ ​protected​ ​from​ ​excess​ ​flooding.​ ​It​ ​should​ ​be​ ​noted​ ​that​ ​because​ ​the​ ​river​ ​has​ ​changed​ ​over​ ​time,​ ​there 
is ​ ​a​ ​noticeable​ ​line​ ​of​ ​blank​ ​space​ ​where​ ​the​ ​river​ ​flowed​ ​at​ ​the​ ​time​ ​of​ ​data​ ​collection​ ​for​ ​this​ ​layer.​ ​This​ ​does​ ​​not​​ ​indicate​ ​a​ ​lack​ ​of​ ​forest​ ​here;​ ​rather,​ ​it​ ​can​ ​be 
assumed​ ​that​ ​prime​ ​farmland​ ​has​ ​taken​ ​its​ ​place. 

Prime ​ ​Farmland 
“Land​ ​that​ ​has​ ​the​ ​best​ ​combination​ ​of 
physical​ ​and​ ​chemical​ ​characteristics​ ​for 
economically ​ ​producing​ ​sustained​ ​high​ ​yields 
of​ ​food,​ ​feed,​ ​forage,​ ​fiber,​ ​and​ ​oilseed​ ​crops, 
when​ ​treated​ ​and​ ​managed​ ​according​ ​to 
acceptable​ ​farming​ ​methods.”​ ​(MassGIS, 
November​ ​2012) 

Farmland​ ​of​ ​Unique ​ ​Importance  
“Land​ ​other​ ​than​ ​prime​ ​farmland​ ​or​ ​farmland​ ​of 
statewide​ ​importance​ ​that​ ​might​ ​be​ ​used​ ​for 
the ​ ​production​ ​of​ ​specific​ ​high​ ​value​ ​food​ ​and 
fiber​ ​crops.​ ​(ei.​ ​Tree​ ​nuts,​ ​cranberries​ ​fruit​ ​and 
vegetables)”​ ​(MassGIS,​ ​November​ ​2012) 

Farmland​ ​of​ ​Statewide​ ​Importance 
This​ ​land​ ​has​ ​the​ ​basic​ ​definition​ ​of​ ​prime 
farmland,​ ​and​ ​are​ ​“...​​ ​nearly​​ ​prime​ ​farmlands 
that​ ​economically​ ​produce​ ​high​ ​yields​ ​of​ ​crops 
when​ ​treated​ ​and​ ​managed​ ​according​ ​to 
acceptable​ ​farming​ ​methods.”​ ​(MassGIS, 
November​ ​2012) 

(MassGIS​ ​November​ ​2012) 
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LAND​ ​USE 

This​ ​layer​ ​includes​ ​a​ ​range​ ​of​ ​uses​ ​for​ ​land;​ ​of​ ​most​ ​importance​ ​here​ ​are​ ​the​ ​following:​ ​Forest,​ ​Non-Forested​ ​Wetland,​ ​Urban​ ​Public/Institutional, 
Low​ ​Density​ ​Residential,​ ​and​ ​Very​ ​Low​ ​Density​ ​Residential. 

A​ ​majority​ ​of​ ​the​ ​land​ ​immediately​ ​surrounding​ ​the​ ​river​ ​is​ ​forested,​ ​but​ ​there​ ​is​ ​also​ ​a​ ​portion​ ​of​ ​Non-Forested​ ​Wetland​ ​very​ ​near​ ​to​ ​the​ ​water’s 
edge,​ ​just​ ​downstream​ ​of​ ​the​ ​bend​ ​on​ ​the​ ​farmland​ ​side​ ​of​ ​the​ ​highway.​ ​There​ ​is​ ​also​ ​a​ ​small​ ​area​ ​of​ ​wetland​ ​between​ ​the​ ​river​ ​and​ ​the 
highway;​ ​according​ ​to​ ​the​ ​land​ ​use​ ​data​ ​(last​ ​updated​ ​in​ ​2009),​ ​the​ ​wetland​ ​is​ ​roughly​ ​11​ ​meters​ ​away​ ​from​ ​the​ ​road.​ ​Because​ ​the​ ​layer​ ​may​ ​be 
outdated,​ ​we​ ​plan​ ​to​ ​confirm​ ​numbers​ ​on-site.  

As​ ​defined​ ​by​ ​the​ ​Massachusetts​ ​Association 
of​ ​Conservation​ ​Commissions,​ ​wetlands​ ​are 
“land​ ​areas​ ​that​ ​contain​ ​surface​ ​water​ ​all​ ​or 
part​ ​of​ ​the​ ​time,​ ​as​ ​well​ ​as​ ​some​ ​adjacent 
land​ ​areas.”​ ​It​ ​is​ ​important​ ​to​ ​ensure​ ​that 
the​ ​process​ ​of​ ​construction​ ​of​ ​the​ ​Greenway 
does​ ​not​ ​destroy​ ​or​ ​alter​ ​the​ ​wetland​ ​in 
accordance​ ​with​ ​the​ ​Massachusetts​ ​Wetlands 
Protection​ ​Act,​ ​enforced​ ​by​ ​the​ ​Williamsburg 
Conservation​ ​Commission. 

(MassGIS​ ​June​ ​2009) 1-4



PARCELS 

It​ ​will​ ​be​ ​helpful​ ​for​ ​the​ ​project​ ​and​ ​the​ ​town​ ​members​ ​to​ ​know​ ​which​ ​lands,​ ​and​ ​maybe​ ​as​ ​a​ ​result,​ ​which​ ​landowners,​ ​may​ ​be​ ​influenced​ ​by​ ​the​ ​construction 
performed​ ​at​ ​this​ ​site. 
This​ ​layer​ ​contains:​ ​“polygons​ ​or​ ​multi-part​ ​polygons,​ ​each​ ​of​ ​which​ ​links​ ​to​ ​one​ ​or​ ​more​ ​assessor​ ​tax​ ​records​ ​(unless​ ​it​ ​is​ ​a​ ​feature​ ​for​ ​which​ ​a​ ​tax​ ​record​ ​has​ ​not 
been​ ​established,​ ​i.e.​ ​public​ ​right-of-way,​ ​most​ ​water,​ ​etc…)”​ ​(MassGIS​ ​October​ ​2017).​ ​Since​ ​most​ ​of​ ​the​ ​lands​ ​around​ ​the​ ​Mill​ ​River​ ​at​ ​the​ ​bend​ ​(with​ ​the​ ​exception​ ​of 
the​ ​road)​ ​are​ ​defined​ ​with​ ​this​ ​layer,​ ​it​ ​means​ ​that​ ​a​ ​majority​ ​are​ ​private​ ​properties.​ ​This​ ​map​ ​allows​ ​for​ ​a​ ​greater​ ​understanding​ ​of​ ​the​ ​legal​ ​aspects​ ​involved​ ​in 
constructing ​ ​the​ ​Greenway​ ​at​ ​this​ ​section.​ ​(MassGIS​ ​Data​ ​-​ ​Level​ ​3​ ​Assessors’​ ​Parcel​ ​Mapping) 

​ ​​ ​​ ​(MassGIS​ ​October​ ​2017) 
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SURFICIAL​ ​GEOLOGY 

This​ ​data​ ​layer​ ​is​ ​“a​ ​​compilation​ ​of​ ​surficial​ ​geologic​ ​materials,​ ​defining​ ​the​ ​areas​ ​of​ ​exposed​ ​bedrock,​ ​and​ ​the​ ​boundaries​ ​between​ ​glacial​ ​till,​ ​glacial​ ​stratified​ ​deposits, 
and​ ​overlying​ ​early-postglacial​ ​and​ ​postglacial​ ​deposits.”​ ​(​MassGIS​ ​Data ​ ​-​ ​Surficial​ ​Geology) 

The​ ​geologic​ ​features​ ​overlap​ ​in​ ​many​ ​places,​ ​with​ ​the​ ​order​ ​corresponding​ ​to​ ​the​ ​order​ ​of​ ​rock​ ​layers.​ ​Thin​ ​Till​ ​Bedrock​ ​is​ ​the​ ​general​ ​underlying​ ​layer​ ​throughout​ ​the 
site,​ ​with​ ​Alluvium​ ​Postglacial​ ​Deposits​ ​the​ ​topmost​ ​layer​ ​immediately​ ​surrounding​ ​the​ ​river.​ ​Coarse​ ​Glacial​ ​Stratified​ ​deposits​ ​are​ ​found​ ​East​ ​of​ ​Route​ ​9,​ ​covered​ ​by 
Stream-Terrace​ ​deposits​ ​over​ ​the​ ​same​ ​area.  

​ ​​ ​​ ​​ ​​ ​​ ​​(MassGIS,​ ​August​ ​2015) 1-6
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MassGIS.​ ​Parcel.​ ​“MassGIS​ ​Data​ ​-​ ​Level​ ​3​ ​Assessors’​ ​Parcel​ ​Mapping.”​ ​October.​ ​2017. 
www.mass.gov/anf/research-and-tech/it-serv-and-support/application-serv/office-of-geographic-information-massgis/datalayers/l3parcels.html ​. 
(October​ ​15,​ ​2017) 

MassGIS.​ ​Land ​ ​Use.​ ​“MassGIS​ ​Data​ ​-​ ​Land ​ ​Use​ ​(2005).”​ ​5​ ​June.​ ​2009. 
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http://www.mass.gov/anf/research-and-tech/it-serv-and-support/application-serv/office-of-geographic-information-massgis/datalayers/soi.html ​. 
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MassGIS.​ ​Surficial​ ​Geology.​ ​“​MassGIS​ ​Data​ ​-​ ​Surficial​ ​Geology ​ ​(1:24,000).”​ ​August​ ​2015. 
http://www.mass.gov/anf/research-and-tech/it-serv-and-support/application-serv/office-of-geographic-information-massgis/datalayers/sg24k.html. 
(October​ ​15,​ ​2017) 
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Date: (5/7/2018)
Revision: C7

SN ID Stakeholder Need Statement
Stakeholder Need 

Source DR ID
Design Requirement 

Statement
Design Requirement 

Specification Design Requirement Source
Verification Protocol for 

DR

Design 
Verification 

Result

Design 
Verification  

Date
Design Verification 
Documentation

SN‐01 Hydraulic model compatibility WMRGC DR‐01
Runs on software that is common 
throughout the professional field

use of HEC‐RAS 1D, as 
standard hydraulic 
modeling software 

WMRGC Meeting Minutes 
11/08/2017

Confirm the use of HEC‐RAS 
1D by retrieving analysis 
output 

Pass 4/9/2018 Figure 13 in Final Report

SN‐02 Accounts for major flood events WMRGC & MassDOT DR‐02
Accounts for the 2, 10, 25, 50 and 
100 year floods

flow values input into 
HEC‐RAS should include 
flow values of the 2, 5, 
10, 25 and 100 year 
floods

WMRGC Meeting Minutes 
11/08/2017

Test flood flow values in HEC‐
RAS model

Pass 5/4/2018 Figure 13 in Final Report

SN‐03
Accurately predicts river velocities for 
storm events

WMRGC & MassDOT DR‐03
Predicts values within 1 ft of 
measured water level data

|Predicted WSE ‐ 
Measured WSE| < 1ft

Brett Towler Meeting Minutes 
2/22/2018

Calculate the error from the 
predicted and actual water 
surface level to be no greater 
than 1ft in 
difference(predicted by Brett‐
Towler or other source)

Pass 5/4/2018
Appendix 6: Accuracy 
Calculations for HEC‐RAS 
Model

SN‐04
Considers the effects of the Brassworks 
dam on the stability of the greenway

WMRGC & MassDOT DR‐04
Quantifies the effect of the 
Brassworks dam on the river 
hydraulics

model includes situation 
with and without dam

WMRGC Meeting Minutes 
9/15/2017

Test HEC‐RAS models with 
and without the Dam

Pass 5/4/2018 Figure 14 from Final Report

SN‐05
Data collected must be compatible with 
future surveys

VHB DR‐05
includes control points in data 
collection

GPS‐located fixed points 
along Route 9 must be 
clearly marked for visual 
recognition by on‐ground 
surverying crew.

WMRGC Meeting Minutes 
10/18/2018

Email Hill Engineers control 
points and ask whether they 
are physically able to locate 
our control points and that 
upon sending them 
electronically, they are able 
to apply the points into their 
master AutoCAD file. 

Pass 4/9/2018
Hill Engineers Email 
Confirmation

Design Verification

DESIGN OUTPUTS

TRACEABILITY 
MATRIX

HEC‐RAS Model at Mill River Greenway on Bend of Route 9

Fereshta Noori, Maya Sleiman, Marcia Rojas, Laura Rosenbauer

This project aims to assess different bank‐retaining alternatives for a greenway project connecting the towns of Haydenville and Williamsburg. The suggested 
alternatives will be informed by a HEC‐RAS hydraulic model of the Mill River along with GIS mapping of the Mill River area.

Stakeholder Needs (SNs) Design Requirements (DRs)

DESIGN INPUTS



Date: (5/7/2018)
Revision: C7

SN ID Stakeholder Need Statement
Stakeholder Need 

Source DR ID Design Requirement Statement
Design Requirement 

Specification
Design Requirement 

Source Verification Protocol for DR

Design 
Verification 

Result

Design 
Verification  

Date Design Verification Documentation

SN‐01
protect riverbank at route 9 bend from 
erosion with the dam

WMRGC & MassDOT DR‐01
withstand velocities predicted by the 
HEC‐RAS model with the dam

Allowable velocity of 
design > Predicted 
velocities for the 100 
year floods (modelled 
with the dam)

WMRGC Meeting Minutes 
11/08/2017

Use the table TS14I–4 from 
NCRS Technical Supplement 
14I and Figure 8–25 from 
NRCS Part 654 Restoration 
Design National Engineering 
Handbook to compare these 
values to those of the HEC‐
RAS design model velocities

Pass 5/4/2018

NCRS Technical Supplement 14I: 
Streambank Soil Bioengineering – Table 
TS14I–4 , NRCS Part 654 Restoration 
Design National Engineering Handbook: 
Chapter 8 Threshold Channel Design – 
Figure 8–25, HEC‐RAS Alternatives Model 
Velocity Outputs (With and Without Dam) 
‐ Refer to Appendix 13

SN‐02
protect riverbank at route 9 bend from 
erosion without the dam

WMRGC & MassDOT DR‐02
withstand velocities predicted by the 
HEC‐RAS model without the dam

Allowable velocity of 
design > Predicted 
velocities for the 100 
year floods (modelled 
without the dam)

WMRGC Meeting Minutes 
11/08/2017

Use the table Table TS14I–4 
from NCRS Technical 
Supplement 14I and Figure 
8–25 from NRCS Part 654 
Restoration Design National 
Engineering Handbook to 
compare these values to 
those of the HEC‐RAS design 
model velocities

Pass 5/4/2018

NCRS Technical Supplement 14I: 
Streambank Soil Bioengineering – Table 
TS14I–4 , NRCS Part 654 Restoration 
Design National Engineering Handbook: 
Chapter 8 Threshold Channel Design – 
Figure 8–25, HEC‐RAS Alternatives Model 
Velocity Outputs (With and Without Dam) 
‐ Refer to Appendix 13

SN‐03
protect greenway from
possible flooding

WMRGC & MassDOT DR‐03
 Prevents river water level from rising 
above the Greenway bank level

Water surface elecation 
of the 100 year flood < 
Elevation of top of 
design

WMRGC Meeting Minutes 
11/18/2017

Run the HEC‐RAS model with 
the alternatives and ensure 
that at the 100 year flood, the 
top water level does not 
exceed the road‐level

Pass 4/26/2018
HEC‐RAS Cross Sections ‐ Refer to 
Appendix 13

SN‐04 Must meet vehicular spatial standards MassDOT DR‐04
minimum shoulder width and 
bikeway width are accommodated

With designs: 
Threshold: shoulder = 
4' Objective: shoulders 
= 5' Greenway width = 
12'

WMRGC Meeting Minutes 
3/28/2018

Confirm in HEC‐RAS cross 
section whether or not top 
width of the road to the river 
is at least 16'

Pass 4/26/2018 Figure 15 from Final Report

SN‐05
Must minimize impact on the various 
aquatic species in the Mill River, and  
their habitat, after implementation

Williamsburg 
Conservation 
Committee

DC‐01
minimizes impact on water 
temperature, allows for vegetation 
and habitat

creates shade, low 
velocity areas, and 
interlocking vegetation

Consideration

Design Verification

TRACEABILITY 
MATRIX This project aims to assess different bank‐retaining alternatives for a greenway project connecting the towns of Haydenville and Williamsburg. The suggested alternatives 

will be informed by a HEC‐RAS hydraulic model of the Mill River along with GIS mapping of the Mill River area.

Bank Protection at Mill River Greenway on Bend of Route 9

Fereshta Noori, Maya Sleiman, Marcia Rojas, Laura Rosenbauer

DESIGN INPUTS
Design Requirements (DRs)Stakeholder Needs (SNs)

DESIGN OUTPUTS
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Appendix 3: HEC-RAS Manual 

This manual gives an overview of the steps needed to create a steady-flow hydraulic analysis in 
HEC-RAS. It explains the steps of creating a project folder, a geometry file, and a steady flow file 
in addition to the input data needed for each of them. It then states the steps to be followed to run 

a steady flow analysis using the created files  
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Manual for Creating a Base Hydraulic Model in HEC-RAS and Running a Steady Flow 
Analysis  

Created by: Maya Sleiman 
Created on: 04/07/2018 

The following document outlines the process of creating a hydraulic model in HEC-RAS 1D and 
running a Steady Flow Analysis on it. This document only covers tools of HEC-RAS that were 
utilized in our project.  

HEC-RAS is an open-source program created by the Hydrologic Engineering Center of the Army 
Corps of Engineers. You can download it at http://www.hec.usace.army.mil/software/hec-
ras/downloads.aspx .  

 

1. Open HEC-RAS. A window like the one below will appear on your desktop.  

 
 

2. To create a new project, go to File > New Project. Navigate to the folder in which you want to 
store your project. Give your project a name and click the ok button on the bottom left. .  
In the example below, I navigated to Desktop>HEC-RAS and created a project 
MillRiver_MS_040620.  

http://www.hec.usace.army.mil/software/hec-ras/downloads.aspx
http://www.hec.usace.army.mil/software/hec-ras/downloads.aspx
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Tip: Store all project files with in the project file. These files will typically include a project, plan, 
geometry, and steady or unsteady flow. 
 
The HEC-RAS main window should automatically update its project path to the name you just 
created, as seen in the figure below.  

 
 
The units are automatically set to US Customary Units but can be changed under Options > Unit 
System (US Customary/SI) 
 

3. To create the plan of your project, click on the View/Edit Geometry Data   . The Geometry 
Data window shown below will appear.  
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To create your river reach, click on the River Reach button .  

You will be prompted to draw a river reach in the white space of the Geometry Data window. 
Click in the space to establish your upstream point end of the reach, and double click somewhere 
else on the space to establish the downstream end of your reach.  
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You will be prompted to name the river you are modelling and the reach within this river, as seen 
in the window above. Click ok. The reach shape will automatically update to show the river name 
and direction of flow as seen below.  
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4. To create cross-sections along your reach, click on the Edit and/or create cross sections button 

on the left side of the Geometry Data window.  
The Cross Section Data window will appear as shown in the figure below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click Options > Create new cross section. You will be prompted to name your cross section as 
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shown in the window below.  

 
Click ok.  
 
Tip: The default numbering mechanism for HEC-RAS is from downstream to upstream. i.e. 
smaller station numbers are further downstream, and river station 0 should be the furthest 
downstream.  
 
Tip: For bigger river projects, river stations are typically numbered based on their location (X or 
Y coordinate, as deemed convenient) 

5. For a new cross section, the following information should be entered to fully define it: 
a. Coordinate data of cross section points: This is entered in the Cross Section Coordinates table. 

Each point is defined by two coordinate values, its station and elevation.  
Station is the distance from a point to the left extremity of your cross-section.  
Elevation is the elevation of the point above mean sea level.  
 
For the purposes of our example, the following (station, elevation) coordinates are entered by 
copying a list of previously-prepared coordinate list from an Excel sheet and pasting the list into 
the Cross Section Coordinates table as shown below. 
Click the Apply Data button to show the resulting changes in the cross section shape.  
 

 
 
Tip: When pasting multiple rows of data from Excel, make sure to select an adequate number of 
cells in the HEC-RAS table before you paste your data. If you only select one cell, only one value 
will be pasted from Excel into HEC-RAS. Unlike Excel, HEC-RAS does not automatically 
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populate the appropriate number of rows and columns based on the number of copied rows and 
columns. 
 

b. Downstream Reach Length: This is the distance between the current cross section and the 
following one downstream. It is divided into Right of Bank (ROB), Left of Bank (LOB), and 
Channel downstream reach lengths. The figures below show the downstream reach lengths of 
cross-section 1.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

c. Manning’s roughness value, which should be assigned for the Right Bank, Channel, and Left 
bank of each cross section.  
 

d. Main Channel Bank Station, which specifies the border-points of the right and left banks.  
 
Tip: Manning’s number can be specified for each of the banks and the main channel as defined by 
item d above. Accordingly, make sure the definition of banks and main channel reflects the 
changes in Manning’s number.  
 

e. Expansion/Contraction Coefficients: These are set to 0.1/0.3 by HEC-RAS. They can be 
changed to reflect flow through inline structures like bridges and weirs.  
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After filling the above values, your Geometric Data window should be similar to the one below: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. To save your geometry data, go the Geometric Data window, click File >  Save Geometry Data 
as, name the file, and place it in the project folder. The Geometry path on the main window of 
HEC-RAS should automatically update to reflect this change.  

 
 

7. To create another cross section, go the Cross Section Data window, click Options > Add a new 
cross section, and repeat sub-steps within step 5. Remember to click Apply Data after editing the 
geometric data and to save your geometry data frequently.  

8. Now that you have fully defined the geometry of your river reach by creating and saving a 
Geometry file, you will define your steady flow conditions.  
To achieve this, click Edit on the main window of HEC-RAS > Steady Flow Data. The window 
below should appear.  
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9. To enter the flow value of your river, type in the flow in the white box under PF 1. PF stands for 
Profile Flow, as shown in the window below.  
You can rename your Profile Flow name: On Steady Flow Data window, click File > Rename 
Flow Title > type in the name of your flow > click ok.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. To define your boundary conditions, click Reach Boundary Conditions. The window below will 
appear, giving you four options for Upstream and Downstream boundary conditions: Known 
Water Surface, Critical Depth, Normal Depth, and Rating Curve.  
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Click on box under Upstream, then click Normal Depth. A window will appear prompting you to 
specify the upstream normal depth slope. This can be estimated by entering the channel slope. In 
our example, we enter 0.0014, meaning that the elevation of the channel changes by 1.4 ft every 
1000 ft of reach length.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Click ok, and repeat for downstream boundary. 
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Click ok, then Apply Data when done.  
 

11. To save your flow data, go to the Steady Flow Data window, click on File > Save Flow Data As 
> name the file, and place it in the project folder. The Steady Flow path on the main window of 
HEC-RAS should automatically update to reflect this change.  

 
 
 

12. To run your model, click Run on the main HEC-RAS window > Steady Flow Analysis.  
You will be prompted to choose a flow regime that is either subcritical, mixed, or supercritical.  
For our example, we will choose mixed. Click Compute. 
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The following window should appear. The blue bars will fill up to indicate the completion of the 
computation. Click close.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



Data Manipulation Documentation 

Created by: Maya Sleiman Created on: 04/07/2018 

 

 

Data Set 1 

Data Set 1 was collected on November 4th, 2017. 

It covers the first six cross sections upstream (XS13 – XS7 in HEC-RAS model). 

 

Below is the original format of the data, as retrieved from the Total Station SD Card by Bob 

Newton (Table 4-1). 

 

Table 4-1: Raw Data from Data Set 1 

 
 

 

 

The data was copied into Excel and the six cross sections were identified as follows. Highlighted 

rows are of coordinates that were taken using a Trimble GeoXH 2005 device (Table 4-2). 

 

Table 4-2: Data from GPS from Data Set 1 

 
 

When plotted on Google Maps (using longitude/latitude format), the coordinate points took the 

shape of the bend but appeared in a different place in Massachusetts. There was likely an error in 

either the information we got from the GPS device (on which the rest of data’s coordinates were 

built) or in the entering of the GPS data into Total Station.  

 

Given that HEC-RAS is not affected by the absolute position of the cross-sections (i.e. where 

they fall on a map) but rather by their relative position to other points in the model (i.e. distances 

and angles between a point and another), there was no reason to resurvey these points. Although 

their location in space was wrong, their relative positions was determined by Total Station, 

making them reliably accurate for the purposes of our model.  



 

Data Set 2  

Data set 2 was collected on March 11th, 2018. It includes XS4 through XS0 (XS7 is 

approximately halfway between the Brassworks Dam and XS0 is slightly downstream of the 

South Main Street Bridge.  

 

Some cross sections in this set were physically surveyed (using Total Station) while others were 

extrapolated using different collected data:  

 XS4 was fully taken using Total Station   

 Location of XS2 and XS2 were surveyed using Total Station; Elevation was 

calculated  using Total Station Elevation of bridge deck measured between bridge 

deck and river  bed. (method fully documented in Appendix X)   

 XS3 was projected from XS2, and XS0 was projected from XS1. 

  

The raw data retrieved from the Total Station by Bob Newton is as follows (Table 4-3):   

 
Table 4-3: Raw Data from Data Set 2 

 
 

 

The data was copied into Excel and the three cross sections were identified as follows. 

Highlighted rows belong to points whose points coordinates were found using a Trimble GeoXH 

6000 device (Table 4-4).  

 

Table 4-4: Figure 4-2: Data from GPS from Data Set 1 

 



Elevation Calculation of Bridge Cross Sections (XS2 and XS1)  

Equation 1 was used to calculate the river bed elevation for each point in XS2 and XS1:  

𝐸𝑅𝐵 = 𝐸𝐵𝐷 − 𝐷𝐵𝐷→𝑅𝐵     Eqn. 1 

Where 𝐸𝐵𝐷 is the Total Station elevation of the bridge deck perpendicularly above a given XS  

𝐷𝐵𝐷→𝑅𝐵 is the measured distance between the bridge deck and the river bed at a given XS 

point  

𝐸𝑅𝐵 is the calculated elevation of a given XS point  

The measured distances where imported into the Excel sheet above, and the equation was applied 

to calculate the elevation of each bridge XS point (Table 4-5).  

Table 4-5: Riverbed Elevation Calculations 

 
 

Creation of XS3 from XS2 For Elevation Data:  

A slope of 0.005 was approximated for the post-dam reach. A ~0.5m elevation drop over ~100m 

was noticed between XS4 and XS1 Slope = 5m/100m = 0.005. The distance between the 2 cross 

sections was measured at approximately 5m.  

The elevation of XS3 was found using Equation 2:  

𝐸𝑋𝑆3[𝑚] = 𝐸𝑋𝑆2[𝑚] + 0.005(5𝑚)       Eqn. 2 



The resulting elevations are listed below (Table 4-6): 

 

Table 4-6: XS3 Elevations 

 
 

 

 

For Station Data:  
All channel points were projected 5m upstream using AutoCAD, as shown in Figure 4-1. 

Additionally, two points were added on both extremities of the cross section ~6.5m away from 

the existing last points. Elevations of the added extremities points were approximated as the 

bridge deck elevation.  

 

 



 
 

Figure 4-1: Projection in AutoCAD 

 

 

 

Creation of XS0 from XS1  

Given the prismatic and uniform nature of the channel downstream of South Main Street Bridge, 

it was decided to create XS0 30m downstream of XS1 (downstream side of the bridge) using a 

projection of XS1. Elevation values of XS0 were found using the previously approximated reach 

slope (0.005) and the distance between the two cross sections (30m) using Equation 3.  

𝐸𝑋𝑆0[𝑚] = 𝐸𝑋𝑆1[𝑚] − 0.005(30𝑚)              Eqn. 3 

 

The resulting values are in Table 4-7. 

Table 4-7: Elevations for XS1 

 



Data Correction  

To correct the location and elevation values of the above two data sets, the following correction 

points were used:  

 GPS coordinates (location, elevation) taken using Trimble GeoXH 6000 device at the 

guardrail of XS12, XS10, and XS8.   

 GPS coordinates taken using the same Trimble at the downstream-side of the bridge 

deck. This is the same point where the Total Station was placed for Data Set 2 collection, 

and so was surveyed earlier along with Data Set 2.   

 A known USGS point surveyed by Hills Engineers.  

 

The collected data is in Table 4-8. 

Table 4-8: Survey Control Points 

  

Elevation Corrections  

For data set 1, differences in elevation between the original XSi_1 and the corrected XSi_1 were 

averaged. The resultant (44.5m) was added to each point in the above data set.  

For data set 2, the difference in elevation between the original USGS point and the Hills 

Engineer USGS point (9m) was added to all points in the data set.  

Note that the hydraulic model was not affected by this change, as the relative distances was 

between the points was unchanged.  

 

 



Location Corrections  

Data set 1 was entered into ArcGIS. Points XS12_1, XS10_1 and XS8_1 were matched to their 

corrected values found in the table above. The rest of the points in the data set were corrected 

accordingly.  

When Data set 2 was entered into AutoCAD, the data has to be flipped and mirrored . We 

hypothesized that we might have entered Easting for Northing and Northing for Easting when 

establishing the location of the Total Station. Similar to Data Set 1, Set 2 was entered into 

ArcGIS and corrected using the Hill Engineers USGS point.  

Using AutoCAD to Find Station Data  
Each of the surveyed cross sections were imported into AutoCAD using the following method:  

 

1. In Excel, use the concatenate tool to create for each coordinate point a cell that contains 

the northing and easting value of the point separated by a comma. To do this, select a 

cell, type “=CONCATENATE (“Northing Cell”, “,”,”Easting Cell”). Drag down the 

above equation for all surveyed points in a cross section.   

2. Copy the column of concatenated points.   

3. In AutoCAD, go to Draw > Multiple Points > paste copied column into dialogue box.   

4. Click Zoom Extent if you cannot see your points.   

 

 
 

Connect the left and right extremity points of a cross section using a line. We will call this line 

(L).  

 

 



5. For all XS points that do not fall on (L), connect the point to (L) using a line 

perpendicular to (L). The intersection between (L) and each of these connecting lines 

forms the “projected points”.  

 

 

6. Locate the left bank extremity of the cross section and measure distances between it and 

all other points on the cross section.  

 

7. In this example, Station data would be as follows: 

Table 4-9: Final Station Data 

 
 

 



Appendix 5: Log Pearson Analysis 

This appendix consists of the documentation for our Log Pearson Type III Analysis on 
the Mill River. The Log-Pearson Type III distribution tells you the likely values of 

discharges to expect in the river at various recurrence intervals based on the available 
historical record. This is helpful when designing structures in or near the river that may 
be affected by floods. It is also helpful when designing structures to protect against the 

largest expected event. According to the U.S. Water Advisory Committee on Water Data 
(1982), the Log-Pearson Type III Distribution is the recommended technique for flood 

frequency analysis.  

To perform the analysis, we started with annual peak flow discharge data from the 
USGS stream gauge on the Mill River at Northampton, then prorated it to our site. We 
used this data to solve the following equation, where x is the discharge value, K is a 

frequency factor, and ​σ​ is the standard deviation of the logx values. 

logx  =​  logx ​+ Kσ​logx 

The frequency factor K is a function of the skewness coefficient and return period, was 
found using the ​frequency factor table ​. For a detailed tutorial of how to calculate the Log 
Pearson Type III distribution, refer to Oregon State University’s “Streamflow Evaluations 

for Watershed Restoration Planning and Design” at the following link: 
http://streamflow.engr.oregonstate.edu/analysis/floodfreq  
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Log Pearson Type III Analysis

Log Person Type III Analysis
Date MM DD YYYY WY Q log10Q Rank Y Y-Ymean (Y-Ymean)

2 (Y-Ymean)
3

4/17/41 4 17 1998 1998 169 2.228 46 2.228 -1.603 2.569356 -4.12E+00 n 21
6/16/42 6 16 1999 1999 2200 3.342 28 3.342 -0.488 0.238520 -1.16E-01 Ymean 3.063
5/9/43 5 9 2000 2000 1300 3.114 36 3.114 -0.717 0.513894 -3.68E-01 SY 0.8423127

11/16/43 11 16 2001 2002 942 2.974 41 2.974 -0.857 0.734032 -6.29E-01 g -1.300
5/21/45 5 21 2002 2002 679 2.832 44 2.832 -0.999 0.997877 -9.97E-01
4/28/46 4 28 2003 2003 1190 3.076 38 3.076 -0.755 0.570419 -4.31E-01 (yrs) (cfs)
5/7/47 5 7 2004 2004 1470 3.167 32 3.167 -0.663 0.440219 -2.92E-01 p RI K YLP3 Q

5/19/48 5 19 2005 2005 2140 3.330 29 3.330 -0.500 0.250394 -1.25E-01 0.99 1.01 -3.211 0.358 2
4/15/49 4 15 2006 2006 1480 3.170 31 3.170 -0.661 0.436321 -2.88E-01 0.5 2 0.21 3.240 1736
4/23/50 4 23 2007 2007 3760 3.575 26 3.575 -0.256 0.065342 -1.67E-02 0.2 5 0.838 3.769 5868
6/8/52 6 8 2008 2008 1380 3.140 33 3.140 -0.691 0.477382 -3.30E-01 0.1 10 1.064 3.959 9097

3/31/53 3 31 2009 2009 923 2.965 42 2.965 -0.866 0.749274 -6.49E-01 0.04 25 1.24 4.107 12798
9/13/54 9 13 2010 2010 1370 3.137 34 3.137 -0.694 0.481757 -3.34E-01 0.02 50 1.324 4.178 15062
5/10/55 5 10 2011 2011 2630 3.420 27 3.420 -0.411 0.168799 -6.94E-02 0.01 100 1.383 4.228 16888
5/1/56 5 1 2012 2012 753 2.877 43 2.877 -0.954 0.910140 -8.68E-01 0.005 200 1.424 4.262 18286

4/22/57 4 22 2013 2013 1050 3.021 40 3.021 -0.810 0.655482 -5.31E-01 0.002 500 1.46232 4.294 19697
4/24/58 4 24 2014 2014 1220 3.086 37 3.086 -0.744 0.554203 -4.13E-01 0.001 1000 1.48216 4.311 20470
6/19/59 6 19 2015 2015 1160 3.064 39 3.064 -0.766 0.587292 -4.50E-01 0.0005 2000 1.49673 4.323 21056
5/15/60 5 15 2016 2016 1680 3.225 30 3.225 -0.605 0.366628 -2.22E-01 0.0001 10000 1.51752 4.341 21923
5/29/61 5 29 2017 2017 1350 3.130 35 3.130 -0.700 0.490664 -3.44E-01
8/14/62 8 14 2018 2018 276 2.441 45 2.441 -1.390 1.931818 -2.69E+00
5/31/63 5 31 63 63 24000 4.380 16 4.380 0.549 0.301844 1.66E-01
4/28/65 4 28 65 65 21700 4.336 20 4.336 0.506 0.255684 1.29E-01
11/4/66 11 4 66 67 42500 4.628 6 4.628 0.798 0.636136 5.07E-01 To adapt this spreadsheet:

4/16/68 4 16 68 68 17000 4.230 23 4.230 0.400 0.159713 6.38E-02

5/22/69 5 22 69 69 28000 4.447 14 4.447 0.616 0.379888 2.34E-01

5/7/70 5 7 70 70 36900 4.567 10 4.567 0.736 0.542018 3.99E-01
5/5/71 5 5 71 71 32200 4.508 12 4.508 0.677 0.458394 3.10E-01
5/8/72 5 8 72 72 23400 4.369 19 4.369 0.538 0.289883 1.56E-01

4/29/73 4 29 73 73 66000 4.820 1 4.820 0.989 0.977599 9.67E-01
6/8/75 6 8 75 75 18500 4.267 21 4.267 0.436 0.190414 8.31E-02
4/4/76 4 4 76 76 39800 4.600 8 4.600 0.769 0.591477 4.55E-01

4/25/77 4 25 77 77 24800 4.394 15 4.394 0.564 0.317695 1.79E-01
3/30/78 3 30 78 78 23900 4.378 17 4.378 0.548 0.299855 1.64E-01
4/29/79 4 29 79 79 53000 4.724 3 4.724 0.893 0.798285 7.13E-01
4/11/80 4 11 80 80 15200 4.182 24 4.182 0.351 0.123226 4.33E-02
9/25/81 9 25 81 81 41500 4.618 7 4.618 0.787 0.619747 4.88E-01
4/28/82 4 28 82 82 29600 4.471 13 4.471 0.640 0.410220 2.63E-01
4/18/83 4 18 83 83 48500 4.686 4 4.686 0.855 0.730912 6.25E-01
6/2/84 6 2 84 84 47500 4.677 5 4.677 0.846 0.715523 6.05E-01

4/19/85 4 19 85 85 17100 4.233 22 4.233 0.402 0.161756 6.51E-02
9/25/86 9 25 86 86 23500 4.371 18 4.371 0.540 0.291881 1.58E-01
4/2/87 4 2 87 87 55400 4.744 2 4.744 0.913 0.833025 7.60E-01
4/7/88 4 7 88 88 13700 4.137 25 4.137 0.306 0.093583 2.86E-02

5/15/89 5 15 89 89 36200 4.559 11 4.559 0.728 0.529840 3.86E-01
10/25/90 10 25 90 91 37500 4.574 9 4.574 0.743 0.552381 4.11E-01

Annual PeakYear LP3 Analysis

1. Replace data in blue with the peak event from each year 
(using USGS data)

2. If the data list (i.e., number of years) is longer or shorter, 
ensure that the range references in red cells are correct.
3. The rest of the file should adjust automatically; primary 

output in green.
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RI p 2.0 1.9 1.8 1.7 1.6 1.5 1.4 1.3 1.2 1.1 1.0 0.9 0.8 0.7
1.0101 0.99 -0.990 -1.037 -1.087 -1.140 -1.197 -1.256 -1.318 -1.383 -1.449 -1.518 -1.588 -1.660 -1.733 -1.806

2 0.5 -0.307 -0.294 -0.282 -0.268 -0.254 -0.240 -0.225 -0.210 -0.195 -0.180 -0.164 -0.148 -0.132 -0.116
5 0.2 0.609 0.627 0.643 0.660 0.675 0.690 0.705 0.719 0.732 0.745 0.758 0.769 0.780 0.790
10 0.1 1.302 1.310 1.318 1.324 1.329 1.333 1.337 1.339 1.340 1.341 1.340 1.339 1.336 1.333
25 0.04 2.219 2.207 2.193 2.179 2.163 2.146 2.128 2.108 2.087 2.066 2.043 2.018 1.993 1.967
50 0.02 2.912 2.881 2.848 2.815 2.780 2.743 2.706 2.666 2.626 2.585 2.542 2.498 2.453 2.407
100 0.01 3.605 3.553 3.499 3.444 3.388 3.330 3.271 3.211 3.149 3.087 3.022 2.957 2.891 2.824
200 0.005 4.298 4.223 4.147 4.069 3.990 3.910 3.828 3.745 3.661 3.575 3.489 3.401 3.312 3.223
500 0.002 4.215 5.108 4.999 4.890 4.779 4.667 4.553 4.438 4.323 4.206 4.088 3.969 3.850 3.730
1000 0.001 5.908 5.775 5.642 5.507 5.371 5.234 5.095 4.955 4.815 4.673 4.531 4.388 4.244 4.100
2000 0.0005 6.601 6.443 6.383 6.122 5.960 5.797 5.633 6.467 5.301 5.134 4.967 4.799 4.631 4.462
10000 0.0001 8.210 7.989 7.766 7.543 7.318 7.093 6.867 6.640 6.412 6.185 5.957 5.729 5.501 5.274

RI p 0.6 0.5 0.4 0.3 0.2 0.1 0.0 -0.1 -0.2 -0.3 -0.4 -0.5 -0.6 -0.7
1.0101 0.99 -1.880 -1.955 -2.029 -2.104 -2.178 -2.252 -2.326 -2.400 -2.472 -2.544 -2.615 -2.686 -2.755 -2.824

2 0.5 -0.099 -0.083 -0.066 -0.050 -0.033 -0.017 0.000 0.017 0.033 0.050 0.066 0.083 0.099 0.116
5 0.2 0.800 0.808 0.816 0.824 0.830 0.836 0.842 0.846 0.850 0.853 0.855 0.856 0.857 0.857
10 0.1 1.328 1.323 1.317 1.309 1.301 1.292 1.282 1.270 1.258 1.245 1.231 1.216 1.200 1.183
25 0.04 1.939 1.910 1.880 1.849 1.818 1.785 1.751 1.716 1.680 1.643 1.606 1.567 1.528 1.488
50 0.02 2.359 2.311 2.261 2.211 2.159 2.107 2.054 2.000 1.945 1.890 1.834 1.777 1.720 1.663
100 0.01 2.755 2.686 2.615 2.544 2.472 2.400 2.326 2.252 2.178 2.104 2.029 1.955 1.880 1.806
200 0.005 3.132 3.041 2.949 2.856 2.763 2.670 2.576 2.482 2.388 2.294 2.201 2.108 2.016 1.926
500 0.002 3.609 3.487 3.366 3.244 3.122 3.000 2.878 2.757 2.637 2.517 2.399 2.000 2.169 2.057
1000 0.001 3.956 3.811 3.666 3.521 3.377 3.233 3.090 2.948 2.808 2.669 2.533 2.399 2.268 2.141
2000 0.0005 4.293 4.124 3.956 3.788 3.621 3.455 3.291 3.128 2.967 2.809 2.654 2.503 2.355 2.213
10000 0.0001 5.047 4.821 4.597 4.374 4.153 3.735 3.719 3.507 3.299 3.096 2.899 2.708 2.525 2.350

skewness, g

skewness, g
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RI p -0.8 -0.9 -1.0 -1.1 -1.2 -1.3 -1.4 -1.5 -1.6 -1.7 -1.8 -1.9 -2.0
1.0101 0.99 -2.891 -2.957 -3.022 -3.087 -3.149 -3.211 -3.271 -3.330 -3.880 -3.444 -3.499 -3.553 -3.605

2 0.5 0.132 0.148 0.164 0.180 0.195 0.210 0.225 0.240 0.254 0.268 0.282 0.294 0.307
5 0.2 0.856 0.854 0.852 0.848 0.844 0.838 0.832 0.825 0.817 0.808 0.799 0.788 0.777
10 0.1 1.166 1.147 1.128 1.107 1.086 1.064 1.041 1.018 0.994 0.970 0.945 0.920 0.895
25 0.04 1.448 1.407 1.366 1.324 1.282 1.240 1.198 1.157 1.116 1.075 1.035 0.996 0.959
50 0.02 1.606 1.549 1.492 1.435 1.379 1.324 1.270 1.217 1.166 1.116 1.069 1.023 0.980
100 0.01 1.733 1.660 1.588 1.518 1.449 1.383 1.318 1.256 1.197 1.140 1.087 1.037 0.990
200 0.005 1.837 1.749 1.664 1.581 1.501 1.424 1.351 1.282 1.216 1.155 1.097 1.044 0.995
500 0.002 1.948 1.842 1.741 1.643 1.550 1.462 1.380 1.303 1.231 1.165 1.105 1.049 0.998
1000 0.001 2.017 1.899 1.786 1.678 1.577 1.482 1.394 1.313 1.238 1.170 1.107 1.051 0.999
2000 0.0005 2.077 1.946 1.822 1.706 1.597 1.497 1.404 1.319 1.242 1.172 1.109 1.052 1.000
10000 0.0001 2.184 2.029 1.884 1.751 1.628 1.518 1.418 1.328 1.247 1.175 1.111 1.052 1.000

skewness, g
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Appendix 6: Accuracy Calculations for HEC-RAS Model

This appendix details the calculations done to measure the accuracy of our model as compared to measured values 
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Stage‐Discharge Relationship
Mill River, Haydenville, MA
South Main St. Bridge
CB: Brett Towler

Datum established on raised curb/deck at left side of center pier on upstream side of S. Main St. bridge.
Measurements of Delta taken with staff gage from datum to water surface elevation (WSE).
Depth established using distance from datum (bridge curb) to channel bottom
Data is unadjasted for lag (delay) between target site (bridge) and USGS 01171500 downstream.

Measured at 10 am on 2/24/18 'channel 15.5 (ft)
DA reported online for USGS 01171500  DAgage 52.6 (mi2)
DA from USGS StreamStats delineation DAtarget 29.3 (mi2)

Ratio 0.5570 ( ‐ )

Date Time Date‐Time 'WSE Depth Flow Flow Reading Notes
(mm/dd/yyyy) (24 hrs) (mm/dd/yy hh:mm) (ft) (ft) (cfs) (A/P) (cfs) ( ‐ ) ( ‐ )

2/24/2018 10:00 2/24/18 10:00 13.9 1.6 243 P 135 LR/MS/BT Rising limb of hydrograph
2/25/2018 12:45 2/25/18 12:45 13.4 2.1 297 P 165 LR/MS/BT Rising limb of hydrograph
2/26/2018 7:40 2/26/18 7:40 13.8 1.7 323 P 179 BT Falling limb; hysteresis?
3/2/2018 14:40 3/2/18 14:40 13.2 2.3 440 P 245 BT Rising limb of hydrograph
4/16/2018 18:10 4/16/18 18:10 12.0 3.5 979 P 545 BT Rising limb of hydrograph

CB: Maya Sleiman 

Key:
E_B 415.36 ft
E_WS

XS2 calculated depth (ft) = E_WS ‐ E_B D_predicted
Diff. 

Flow (cfs) E_WS (ft) D_predicted(ft) Depth (ft) Diff.  (ft)
243 417.03 1.67 1.6 ‐0.07
297 417.19 1.83 2.1 0.27
323 417.25 1.89 1.7 ‐0.19
440 417.53 2.17 2.3 0.13
979 418.54 3.18 3.5 0.32

XS2 WS Elevation (ft) as outputed by HEC‐RAS (ft)

Difference between measured and HEC‐RAS predicted depth

The HEC‐RAS predicted river depth (D_predicted) at the upstream‐facing side of the Bridge 
(XS2) is calculated by subtracting the river bed elevation at the middle of XS2 (E_B)  from 
the WS Elevation outputed by HEC‐RAS at XS2 (E_WS).

XS2 Bed Elevation at middle pier (ft)
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Appendix 7: Documentation of Site Visits 

The following is a compilation of the eleven site visits that we conducted from October to 
March. Site Visits 6 and 10 were major bathymetric data collection visits. In Site Visit 6 we 

collected seven cross sections at the Route 9 bend; XS7 through XS13. Site Visit 10 consisted of 
the Mid-Section and Bridge cross sections, with a total of two cross sections; XS2 and XS4. In 

Site Visit 11 we set up control points for our two bathymetry data collections. 
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Site Visit Summary 1 
 
Location: Mill River Route 9 bend; approached from Valley View Farms 

Day: Monday, September 18, 2017 

Time: 1:00PM - 3:00PM 

Members Present: Gaby, Nick, Carl, Fereshta, Maya, Laura, Marcia 

CB: Marcia Rojas 
 
The site visit consisted of observing the sections between the brassworks dam and the 
straightaway right after the bend of route 9 (“The Pinch”). 
On the drive over to the site we followed the roads that ran directly alongside/or nearest to the 
river. In some of the sections the stream was small and the height of the current water level to the 
top seemed low.  
 
Brassworks - Just Downstream of Dam 
We first arrived at the brassworks parking lot where we entered through a small incline path to 
the downstream side of the dam. There was a sandbar which we stood on.  
The dam was substantially broken, a result of the last hurricane. The biggest break was at the far 
end, indicating a deeper and faster flow on the south side of the river at this point. On that same 
side, there is an abutment. The whole bridge itself was build here specifically because of the 
availability of bedrock for the foundation.  
Downstream of the dam, remnants of the fallen bedrock pieces of the dam are visible. 
 
Brassworks - Just Upstream of Dam 
Just upstream, standing over a wall at the Brassworks parking lot we could see that the flow in 
the areas of large rocks has high flow (Figure 7-1). 

 
Figure 7-1: Sightline Off Parking Lot Wall into Upstream Section of Dam (left); View from Parking Lot Wall (right) 
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Williamsburg Snack Bar - At the bend 
Here we could see the clear bend of the road and river. There was very little shoulder, under 2 
feet at some points. The cars drive by very quickly. The river itself is pretty far down and it is 
hard to see the water even from where we were standing on top of a slope. Farther down there is 
rock retainment by metal mesh.  

 
Figure 7-2. From north side of river, across the road on slope, next to Williamsburg 
               Snackbar on right side, looking down towards the Route 9 bend 
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Site Visit Summary 2 
 
Location: Mill River Route 9 bend; approached from Valley View Farms 

Day: Friday, October 6, 2017 

Time: 3:00PM - 5:30PM 

Members Present: Maya, Fereshta, Laura, Brett, Nick 
 
 
Notes for collecting data: 
● Try to pick places for the total station (Leica) such that you move it as little as possible.  
● HEC RAS does not account for local turbulences, so we should make sure to note those 

when collecting data. How? 
● Look for anomalies when taking a cross section. For example: 

○ Manning’s coefficient of friction changes significantly.  
○ Hydraulic jumps (when flow moves from super to subcritical). 

● Types of resistance in streamflow: 
○ Skin drag (due to Manning’s wall roughness) � what HEC-RAS can model 
○ Bed form resistance (drag resistance or momentum loss) � due to bed vegetation, 

huge rocks, etc.  
○ Wave resistance from distortion of free surface  
○ Turbulence due to local acceleration that cause flow unsteadiness 

● HEC-RAS assumes a flat surface.  
● Think about your stream of focus (i.e. 100 year flood, winter flow, low flow during the 

summer, etc.). This will determine what you will be looking for during a site visit for data 
collection. For example: a stream contains a half-meter-high boulder. Do we care about 
this in the case of a 100-year flood event or during winter flows? Probably not 

 
Total station data collection: 
● At each cross section, 5 points will be taken (at a minimum): 

○ Floodplain boundary points (2) 
○ Water level boundary points (2) 
○ Thalweg (1) 

● For each of these three portions (floodplain 1, water bed, floodplain 2), a Manning’s 
number can be assigned.  

● Take as many pictures during site visits so you can refer to bed-properties (any boulders, 
mean size of rocks, etc.). This might later help in the calculation of Manning’s roughness 
coefficient.  
○ Use put a ruler in the picture when applicable.   
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Things we need before our next site visit: 
● Machete 
● 50 ft steel tape 
● 6-12 inch ruler 
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Site Visit Summary 3 

 

Location: Mill River Route 9 bend; approached from Valley View Farms 

Day: Sunday, October 22, 2017 

Time: 8:00AM - 12:00PM 

Members Present: Maya, Marcia, Fereshta, Laura 

 

Observations: 

● We arrived at the river’s edge and entered the river across from the point bar (Figure 7-3, 

point 1) without equipment to scope out a better access point closer to locations for 

taking measurements. Our goal is to minimize time carrying the equipment while in the 

river in order to avoid hazards related to personal safety or damage to equipment. 

● Water level appeared low, similar to previous site visits earlier in the Fall. 

● Rocks were larger in diameter upstream (Figure 7-4) as compared to downstream (Figure 

7-5). 

 

Completed Tasks: 

● Marked reference points at the dam abutments with spray paint, and recorded GPS 

locations for use in future surveying 

● Identified viable access points to river (Figure 7-3, points 1 & 2) 

● Collected cross section data at dam using “Known Backsight” method 

 

For next visit: 

● Take remaining cross-sections, starting with upstream boundary 

● Read collected data points using software (reach out to Bob Newton for access) 
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Figure 7-3: Locations of Importance at Site 
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Figure 7-4: Upstream 

 

 
Figure 7-5: Downstream 
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Site Visit Summary 4 
 
Location: Mill River Route 9 bend, Bridge, Brassworks Dam (approached from both sides) 
Day: Monday, October 30, 2017 
Time: 1:30PM - 3:00PM 
Members Present: Laura, Sue Froehlich 
 
Observations: 

• Much higher flows than last visit - not safe for wading in (Figure 7-6) 
• River level approximately 3 ft high at peak – noted wetted soil and depressed vegetation 

(Figure 7-7) 
 
Tasks completed: 

• Velocity test 
o Placed two bricks ~21 ft apart and measured time it took for a stick to float the 

distance 
o 21 ft / 3 sec = 7 ft/s 

 
For next visit: 

• Check measurements at USGS gauge 
• Can take the bus to check on flow in the future (don’t need to bring equipment) 

 

 
Figure 7-6: Upstream of the dam 
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Figure 7-7: Depressed vegetation and wetted soil 

 

 
Figure 7-8: Using observed soil and vegetation conditions to estimate river height at peak 
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Site Visit Summary 5 
 
Location: Mill River Route 9 Bend, Approached from route 9 
Day: Thursday, November 2, 2017 
Time: 8:00 am- 3:00 pm 
Members present: Marcia Rojas, Maya Sleiman, Fereshta Noori 
CB: Fereshta Noori 
 
Observations: 

• We approached the river from Route 9, with the goal of making a full plan for 
measurement in the next site visit. The river flow was faster and water level higher than 
last visit. 

• Some of the big rocks for erosion protection of the bend were moved to the middle of the 
road by water flow. (Figure 7-9) 

• Wooden parts of the railing were angled towards the flow of the river. 
• Vegetation on the floodplain were leaning on the ground, towards the river flow. (Figure 

7-10) 
 
Completed tasks: 

• Walked and observed around the site (bend) to choose best access points. 
• Decided on our measurement strategy for the next site visit. 
• Chose fixed points for measurement. 
• Chose measurement cross-sections based on the need, vegetation, and access possibility. 

 
For next visit: 

• Start collecting data at the cross-sections chosen in this visit. 
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Figure 7-9: Bank protection rocks in the river 
 

 
Figure 7-10: Vegetation leaning toward water flow 
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Site Visit Summary 6 
 
Location: Mill River Route 9 bend (approached from Route 9 side of river) 
Day: Saturday, November 4, 2017 
Time: 8:00AM - 3:00PM 
Members Present: Marcia, Fereshta, Maya, Laura 
 
Observations: 

• Environmental conditions 
o ~35 ºF 
o Sunny 
o Low wind 
o Moderate river flow - still safe to walk in, but higher than initial site visits 

• Trouble collecting some points with woody vegetation blocking sightlines 
• Difficult traveling along road 
• Points E10 and E11 are repeats; delete E10 
• Point E16 may be the same as E17; if so, delete one 
• Point E36 is questionable (hit ‘record’ before ‘dist’) 
• Total station appeared to lag – possibly due to colder temperatures 

 
Tasks completed: 

• Collected cross section data for points 8 through 12 (Figure 7-11) plus one additional 
cross section between 7 and 8 that was determined useful at the site 

• Moved total station 4 times, in the following order: 
o Point 12 
o Point 11 
o Point 10 
o Point 8 

• Worked in pairs: one set with total station (Figure 7-12) and one with receiver (Figure 7-
13) 

o Traded off responsibilities to allow each team member hands-on experience 
o Developed visual cues to communicate across the river 

• Took photos of rock size at measurement points (Figure 7-14) 
 
Follow-up tasks: 

• Send data to Bob Newton to export onto computer 
• Check USGS station measurements 
• Input data into HEC-RAS 
• Return survey equipment to Geo department 
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Figure 7-11. Labeled sections 

 

 
Figure 7-12: Collecting data, facing total station with receiver (Fereshta) in the river 
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Figure 7-13: Collecting data, facing receiver with total station by guardrail 
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Figure 7-14: Sample of rock size at measurement points 
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Site Visit Summary 7 
 
Location: Mill River Route 9 bend (approached from Route 9 side of river) 
Day: Tuesday, December 19, 2017 
Time: 2:00PM - 5:00PM 
Members Present: Marcia, Fereshta, Maya, Laura 
CB: Laura Rosenbauer 
 
Observations: 

• Environmental Conditions 
o ~40ºF, 4°C 
o Snow and ice 
o Cloudy 

• Obstacles: 
o Because the ground was frozen, we had difficulty securely staking in the total 

station. We level the equipment several times throughout the process. 
o Ice was present at various points in the river 

§ For the most part, ice was safe to walk on 
§ We assumed the river bed elevation did not vary significantly from 

surrounding points where we successfully took measurements 
o Attempted cross section further downstream 

§ Large sections of ice and the sun setting prevented completion 
§ Access to river at the bridge is difficult -- need to brainstorm alternative 

methods of data collection for this section of the river for next site visit 
 
Task Completed: Took one cross section immediately downstream of the dam (Figure 7-15) 
 
Follow-up tasks: 

• Return equipment to CEEDS 
• Debrief site visit with Bob Newton/discuss collecting data in winter 
• Select date for completing cross-sections 
• Discuss and write out steps for next site visit 
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Figure 7-15: Flowing Water Shown in Blue; Dam Abutments Shown in Orange; Path of Data Collection 

Shown in Red 
 

 
Figure 7-16: View of River Midway Between Bridge and Dam 
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Site Visit 8 Summary  
 
Location: Mill River Route 9 Bend, Approached from Route 9 
Day: Wednesday, January 31, 2017 
Time: 7:00 am- 8:30 pm 
Temperature: 14°F, -9°C 
Members present: Marcia Rojas, Maya Sleiman, Laura Rosenbauer 
CB: Maya Sleiman 
 
This site visit was completed to:  

• Assess stream conditions (frozen water thickness, flow intensity, water level, etc.) 
• Locate cross sections for upcoming surveying and their access points 

 
Observations: 

• Water flow was comparable to flows during previous site visits, not too strong to access 
• Water depth was also comparable to flows during previous site visits, i.e. accessible.  
• Obstructions/Ice 

o Uneven ice coverage - thick in some places (i.e. can be walked on safely as seen 
in Figure 1), and thin in others (i.e. cracking hazard as seen in Figure 7-18).  

o Dam cracking is visible (Figure 7-19) compared to fall conditions (Figure 7-20) 
o Ice formations at the edges of the channel downstream of the dam. There is a gap 

between the surface ice formation and the water level (Figure 7-21).  
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Figure 7-17: Thick ice (area roughly marked) near dam, safe to walk on

 
Figure 7-18. Thin Ice formed on channel edge, prone to cracking, unsafe to walk on 

 

 
Figure 7-19: Water flowing through Dam cracks 
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Figure 7-20: From initial site visit in Sep. 2017; shows no water flowing through right hand 

portion of the dam 
 

Decision regarding cross-section location selection:  
• The cross section at the dam will not be retaken, as accessibility has not improved since 

last site visit. Even with no ice formations, surveyors cannot move any closer to the dam 
due to strong current.  

• The mid-section between the dam and the bridge will be taken at the location show in 
Figure 5. This location was chosen due to the absence of ice formations at its edges, thus 
facilitating access. 

• Due to the complexity of river access at the bridge, an alternative surveying method was 
suggested. Attached is an explanation. 
  

  
Figure 7-21: Chosen location for middle cross section (marked with dashed line) shows minimal 

surface ice formations on edges. 
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Site Visit 9 Assessment Summary  
 
Location: Mill River, Main St bridge and Brassworks dam 
Day: Thursday, February 8, 2018 
Time: 2:00PM - 3:00PM 
Temperature:  28°F, -2°C 
Members present: Maya Sleiman, Laura Rosenbauer 
CB: Maya Sleiman 
 
This site visit was completed with the goal of assessing the site before our site visit 9 originally planned 
for Friday 02/09/18. 
 
The following was noted:  

• More ice has formed on the edges. As a result, the river is more constricted especially after the 
dam. (Figure 7-22) 

 

 
Figure 7-22. More Ice has formed on the river edges, further constricting the flow.  

 

• At the mid-section: ice has formed on edges at places where we had initially situated our cross 
section.  
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Figure 7-23. Access to middle cross section is more restricted following ice formation on edge 

 
• The Bridge is approximately 18 ft high above the river bed. 
• The plumbob was lowered to the river using the tape. The plumbob weight was not heavy enough 

to remain perpendicularly below us and was instead pushed by the river flow approximately 1m - 
2m in the direction of the flow. 
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Site Visit Summary 10 
 
Location: Mill River, Between Brassworks Dam and State Street Bridge  
Date: Saturday, February 24, 2018 
Time: 7:30AM - 11:30AM 
Team Members Present: Marcia, Fereshta, Maya, Laura 
Supporters Present: Sue Froehlich, Paul Wetzel, Brett Towler 
CB: Fereshta Noori 
 
Description: 
This site visit was planned with the goal of collecting bathymetric data from three cross-sections; 
between Brassworks Dam and S State Street Bridge, at S State Street Bridge upstream, and S 
State Street Bridge downstream. 
 
Observations: 

• Environmental Conditions 
o 50/31ºF, 10/0°C 
o Some ice blocks at the river bank (Figure 1) 
o Partly Cloudy 

• Obstacles: 
o High water flow 

§ Velocity at the middle of cross-section was 3-4 ft/s (taken at the cross-
section between dam and bridge) 

§ A rope was stretched across the river cross-section and tied to trees on 
either sides of river to provide stability (Figure 7-24) 

§ It was not easy/safe to get velocity measurements at deepest area of cross 
section 

§ Due to the high flow, cross-sections at the bridge were taken using a 
telescope calibrated rod instead of tape measure and plumbob in “plumbob 
bathymetry method” (Figure 7-25) 

 
Task Completed: Took one cross section in between S State Street Bridge and Brassworks 
Dam, and two cross-sections next to the bridge, both upstream and downstream. Collected 
velocity and water level measurements at cross-section between bridge and dam.  
 
Follow-up tasks: 

• Return equipment to CEEDS 
• Get site visit data from Bob and prepare them for entering in HEC-RAS 
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Figure 7-24: River Safety Line
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Figure 7-25: Survey Collection for XS4 
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Site Visit Summary 11 
 
Location: Mill River Route 9 bend at Williamsburg Snack Bar (approached from Route 9 side of 
river), Brassworks Dam, & S. Main St. bridge 
Day: Sunday, March 11, 2018 
Time: 9:30AM - 1:00PM 
Temperature: 33 - 40F 
Members Present: Fereshta, Laura, Maya, Marcia 
CB: Marcia Rojas 
 
Goal: Relocation of control points for data correction and documentation. 
 
Equipment: Trimble GeoXH 2005 Series Pocket PC set to  
                    Massachusetts State Plane Coordinate System 
 
Tasks Completed: 

• Collected and located two control points from each previous site visit at three major locations:  
o S. Main St. Bridge  
o Brassworks Dam 
o Route 9 Bend at the Williamsburg Snack Bar 

Table 1 features the points in the order that the major locations were stated. Figure 1 points out 
the major sections. The following pages provide further detailed imagery on each section, the 
points, and their surrounding. 

 

Table 7-1. Control Points from three major project sections 

 N E Elevation 
BridgeTS - CP 903381.38 100852.75 131.4 
USGS - CP 9034067.27 100845.05 129.7 
DamTS - CP 903567 100666.9 132.5 
XS 8 - CP 903982 100611.9 137.5 
XS 10 - CP 904041.65 100572.95 136.4 
XS 12 - CP 904079.4 100494.54 137.6 
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Figure 7-26. Major project sections 
 
S. Main St. Bridge  
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BridgeTS - CP = Bridge total station control point 

 
Figure 7-27: Site Visit 10, total station base location on S. Main St. bridge for post-dam data collection 
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S. Main St. Bridge cont’d. 
USGS - CP = USGS 1933 Benchmark control point 

 

 
Figure 7-29: Site Visit 11, USGS benchmark 1933 

 

 
Figure 7-30: Location of USGS benchmark, looking upstream from bridge, in the brush on the right hand side 
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Brassworks Dam 
DamTS - CP= Brassworks Dam total station control point 

 
Figure 7-31: Entry point location to the lower dam area, looking upstream 
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The Route 9 Bend at the Williamsburg  
XS 8 - CP = Cross Section 8 control point 
XS 10 - CP = Cross Section 10 control point 
XS 12 - CP = Cross Section 12 control point 

 
Figure 7-34: Cross section 8, 10, and 12 left of bank (LOB, looking downstream) control points 
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The Route 9 Bend at the Williamsburg cont’d. 
XS 8 – CP 
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The Route 9 Bend at the Williamsburg cont’d. 
XS 8 – CP 
 

 
Figure 7-37: View of river in front of XS 8 - CP location 
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The Route 9 Bend at the Williamsburg cont’d. 
XS 10 - CP 
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The Route 9 Bend at the Williamsburg cont’d. 
XS 12 - CP 

 
Figure 7-42: XS 12 - CP location, looking left onto the road towards Snack Bar 

 

Follow-up tasks:  
• Share control points with Hill Engineers surveying team 
• Adjust and join data sets based on control points 
• Build a GIS layer with corrected data points 
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Appendix 8: Dam and Cross Section 6 Development 

This document includes our interpretation and process of dam implementation in our model. This 

document is developed by Brett Towler; we made some changes in this document to make it 

closer to the current conditions: Cross-section 6 developed in this document is wider than the 

actual cross-section. We used USGS map to estimate the width of this cross-section and the edge 

of river banks on left and right ends of the channel. Below is shown developed cross-section 6 

before and after width adjustment. 
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Inline Dam Structure Development 

 

Figure 1. The red dashed line represents cross‐section 6 without adjustment, and the solid blue line is 
after width adjustment. 



In the current HEC‐RAS model, cross section (XS) 6 represents the crest of the 
(partially breached) Brassworks dam; XS 5 is 22 feet downstream below the dam.

dam

XS 5 XS 6

Modeling the dam as a cross‐section 
inaccurately represents storage and 
prevents us from estimating future 
post‐removal conditions.
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We want to alter XS 6 so that is represents the channel bottom, or more accurately
a proposed future channel post dam removal.

XS 5 XS 6

If XS 6 represented the channel 
bottom, then the river slope would 
look like this

To model the influence of the dam; we will 
build an “inline structure” on top of XS 6.  
This has several advantages; one being that 
you may easily turn on and off the structure 
to model pre‐ and post‐dam conditions
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Synthesizing a modified XS 6:  We didn’t survey the bottom, but we can synthesize 
the cross section based on visual evidence

The (partially breached) dam is built 
from placed stone and these photos 
suggest the channel bottom is below 
the lowest point in the breach.

The dam was likely built on bedrock 
(i.e. ledge).
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Synthesizing a modified XS 6:  We didn’t survey the bottom, but we can synthesize 
the cross section based on visual evidence

And there is evidence that the 
upstream side is choked with 
sediment/transported material

This is common with run‐of‐river 
dams; upstream they are chocked 
with sediment.  While this reduces 
storage with the dam in place, keep 
in mind this material with rapidly 
flush out and the stable channel 
slope will re‐establish once the dam 
is removed.
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Here is the existing XS 5 that captures the channel bottom below the dam.
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And here’s XS 6, the dam crest.  How do we modify this to represent the channel?

8-8



If we superimpose the 2 XS on top of each other using a common scale, we can
envision the drawing below as what you would see looking downstream from the 
impoundment (if you had x‐ray vision).
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Look at XS 5 (below the dam), and begin to modify it to represent XS 6 (without the 
dam).  First, lets assume that the base of the dam was originally chipped to a level 
sill to provide a foundation for the placed stone… and that this sill is at about 
elevation 424 ft. 

assumed bedrock sill

8-10



Existing slope on river right

We also want to preserve the river right bank topography that you noted in your 
survey at XS 6.  That bank is not part of the dam and will remain after removal.  
However, we do need to extrapolate the slope down to the channel bottom.
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Finally, we can assume that the dam is what remains!  We’ll use what is gray to 
describe the new XS 6 and what is red to describe the inline structure.

Partially breached dam will be 
described as an inline structure 
(and hydraulically as a weir)
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Now, by hand, modify XS 6 so that its geometry is represented by the blue line.  I’ve 
used 6 points, you can certainly use more if necessary.
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From the geometry editor, create the inline structure (button on left) and model it 
as a broad crested weir with a coefficient of 3.0 using (at least) the 7 points below.

With this weir, you have another 
calibration “dial”, the weir coefficient.  
Also, you can run the model with the 
structure in place or removed to 
compare pre‐ and post‐removal 
conditions.

8-14



This table shows a summary of water surface elevations and velocities in each cross-section for 2, 10, 25, 50, and 100-year flood events both with and without the dam. It also includes velocity and elevation changes after removal of the Brassworks Dam.

Appendix 9: Change of Hydraulic Conditions Due to Dam Removal  



Cross-Section Flood Event (yr)
Water Surface Elevation (ft) % Elevation 

Change After 
Dam Removal

Channel Velocity (ft/s) % Velocity 
Change After 
Dam RemovalDam NoDam Dam NoDam

13 2 447.37 447.37 0.0000 6.36 6.36 0.00
13 10 447.96 447.96 0.0000 7.39 7.39 0.00
13 25 448.17 448.17 0.0000 7.68 7.68 0.00
13 50 448.38 448.38 0.0000 7.53 7.53 0.00
13 100 448.64 448.64 0.0000 7.12 7.12 0.00
12 2 442.85 442.85 0.0000 11.59 11.59 0.00
12 10 444.29 444.29 0.0000 11.93 11.93 0.00
12 25 444.92 444.92 0.0000 11.79 11.79 0.00
12 50 445.3 445.3 0.0000 11.81 11.81 0.00
12 100 445.52 445.52 0.0000 12.1 12.1 0.00
11 2 436.98 436.98 0.0000 14.69 14.69 0.00
11 10 437.68 437.68 0.0000 18.22 18.22 0.00
11 25 437.88 437.88 0.0000 19.65 19.65 0.00
11 50 438.02 438.02 0.0000 20.38 20.38 0.00
11 100 438.16 438.16 0.0000 20.79 20.79 0.00
10 2 437.18 437.18 0.0000 9.43 9.43 0.00
10 10 438.43 438.43 0.0000 11.24 11.24 0.00
10 25 438.86 438.86 0.0000 11.84 11.84 0.00
10 50 439.13 439.13 0.0000 12.19 12.19 0.00
10 100 439.38 439.38 0.0000 12.43 12.43 0.00
9 2 430.24 430.24 0.0000 21.67 21.67 0.00
9 10 431.18 431.18 0.0000 24.22 24.22 0.00
9 25 431.51 431.51 0.0000 24.98 24.98 0.00
9 50 431.72 431.72 0.0000 25.43 25.43 0.00
9 100 431.9 431.9 0.0000 25.81 25.81 0.00
8 2 431.85 431.79 0.0139 6.06 6.13 1.16
8 10 433.57 433.36 0.0484 7.76 8.06 3.87
8 25 434.16 433.87 0.0668 8.21 8.62 4.99
8 50 434.51 434.18 0.0759 8.47 8.95 5.67
8 100 434.81 434.45 0.0828 8.69 9.23 6.21
7 2 431.75 431.69 0.0139 5.41 5.48 1.29
7 10 433.48 433.25 0.0531 6.98 7.25 3.87
7 25 434.06 433.76 0.0691 7.44 7.81 4.97
7 50 434.42 434.07 0.0806 7.71 8.15 5.71
7 100 434.71 434.33 0.0874 7.94 8.42 6.05
6 2 431.58 426.04 1.2837 2.16 8.14 276.85
6 10 433.26 426.96 1.4541 3.09 9.8 217.15
6 25 433.82 427.3 1.5029 3.41 10.33 202.93
6 50 434.15 427.5 1.5317 3.62 10.65 194.20
6 100 434.44 427.68 1.5560 3.79 10.92 188.13



Cross-Section Flood Event (yr)
Water Surface Elevation (ft) % Elevation 

Change After 
Dam Removal

Channel Velocity (ft/s) % Velocity 
Change After 
Dam RemovalDam NoDam Dam NoDam

5 2 424.48 422.94 0.3628 4.21 14.6 246.79
5 10 425.65 423.34 0.5427 4.57 16.83 268.27
5 25 426.11 423.45 0.6243 4.67 17.65 277.94
5 50 426.41 423.52 0.6778 4.72 18.1 283.47
5 100 426.67 423.59 0.7219 4.76 18.49 288.45
4 2 420.9 420.9 0.0000 7.76 7.76 0.00
4 10 422.12 422.12 0.0000 9.81 9.81 0.00
4 25 422.53 422.53 0.0000 10.52 10.52 0.00
4 50 422.78 422.78 0.0000 10.95 10.95 0.00
4 100 423 423 0.0000 11.3 11.3 0.00
3 2 419.14 419.14 0.0000 8.04 8.04 0.00
3 10 420.41 420.41 0.0000 9.77 9.77 0.00
3 25 420.86 420.86 0.0000 10.32 10.32 0.00
3 50 421.14 421.14 0.0000 10.65 10.65 0.00
3 100 421.4 421.4 0.0000 10.89 10.89 0.00
2 2 419.1 419.1 0.0000 7.58 7.58 0.00
2 10 420.36 420.36 0.0000 9.27 9.27 0.00
2 25 420.8 420.8 0.0000 9.83 9.83 0.00
2 50 421.06 421.06 0.0000 10.18 10.18 0.00
2 100 421.31 421.31 0.0000 10.45 10.45 0.00
1 2 418.41 418.41 0.0000 9.25 9.25 0.00
1 10 419.6 419.6 0.0000 11.07 11.07 0.00
1 25 420.01 420.01 0.0000 11.71 11.71 0.00
1 50 420.29 420.29 0.0000 12.04 12.04 0.00
1 100 420.51 420.51 0.0000 12.35 12.35 0.00
0 2 416.69 416.69 0.0000 9.69 9.69 0.00
0 10 417.68 417.68 0.0000 12.16 12.16 0.00
0 25 418.05 418.05 0.0000 12.9 12.9 0.00
0 50 418.27 418.27 0.0000 13.38 13.38 0.00
0 100 418.47 418.47 0.0000 13.75 13.75 0.00



Appendix 10: Initial Screening of Designs 
 
 

This appendix details the reasoning behind our initial elimination of log jams, gabions, 
traditional crib walls, timber retaining wall, and brush mattresses. These decisions took place 

prior to our formal concept selection process. 
 
  



Log Jams 
Log jams were ruled out early because they were likely to increase water levels and lead to 
flooding. Additionally, they have a high potential for risk within the first 5 years, which our 
clients have expressed concern over. Although they could potentially be paired with other 
alternatives to overcome these drawbacks, the moderately high cost of log jams makes them an 
unattractive option. Compounding all of these factors, we decided to eliminate log jams. 
 
Gabions 
Gabions are an expensive hardscaping alternative, with very little load-bearing capacity. We 
researched vegetated gabions, as the vegetation would overcome the traditional structure’s lack 
of visual aesthetics, reduce the increase in temperature, and allow vegetation to grow. However, 
the addition of plants would compromise the structural integrity entirely. Gabions are 
geometrically incapable of being paired with a retaining wall or any other load-bearing structure, 
so for this reason we eliminated them. Additionally, we feel confident about our decision to 
remove gabions as an option considering the fact that they already exist along a section of the 
river, and clearly they are not sufficient since we are currently looking for other options. 
 
Traditional Crib Walls 
Traditional Crib Walls are most often used on land, typically along roadways. Because our site is 
on a river, and therefore provides the necessary water, soil, and sun exposure, it is much more 
advantageous to use live crib walls in the place of traditional crib walls. We did not find research 
indicating structural weakening due to vegetation, as was the case with gabions. In every case, 
we would therefore prefer live crib walls, so we eliminated their traditional counterpart. 
 
Timber Retaining Wall 
In discussing retaining walls with our liaisons, they indicated that they had already decided on 
concrete for the wall’s material. Live crib walls already provide us with an alternative wall 
composed of wood, so we do not need to consider timber retaining walls as well. 
 
Brush Mattress 
Brush mattresses are similar to brush layers, but brush layers have the additional benefit of being 
encapsulated in geotextiles, providing more form and structure. We consequently decided to 
eliminate this alternative from consideration. 
 



Appendix 11: Velocities and Water Surface Levels of Existing Conditions at the Bend for 2, 50, and 100 year flood

This appendix lists the outputs from our existing conditions model in HEC-RAS.
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HEC-RAS  Plan: Plan 01   River: Mill River   Reach: 1
Reach River Sta Profile Q Total W.S. Elev Vel Chnl

(cfs) (ft) (ft/s)
1 13      2 yr 1351.00 447.37 6.36
1 13      10 yr 2365.00 447.96 7.39
1 13      25 yr 2775.00 448.17 7.68
1 13      50 yr 3042.00 448.38 7.53
1 13      100 yr 3279.00 448.64 7.12

1 12      2 yr 1351.00 442.85 11.59
1 12      10 yr 2365.00 444.29 11.93
1 12      25 yr 2775.00 444.92 11.79
1 12      50 yr 3042.00 445.30 11.81
1 12      100 yr 3279.00 445.52 12.10

1 11      2 yr 1351.00 436.98 14.69
1 11      10 yr 2365.00 437.68 18.22
1 11      25 yr 2775.00 437.88 19.65
1 11      50 yr 3042.00 438.02 20.38
1 11      100 yr 3279.00 438.16 20.79

1 10      2 yr 1351.00 437.18 9.43
1 10      10 yr 2365.00 438.43 11.24
1 10      25 yr 2775.00 438.86 11.84
1 10      50 yr 3042.00 439.13 12.19
1 10      100 yr 3279.00 439.38 12.43

1 9       2 yr 1351.00 430.24 21.67
1 9       10 yr 2365.00 431.18 24.22
1 9       25 yr 2775.00 431.51 24.98
1 9       50 yr 3042.00 431.72 25.43
1 9       100 yr 3279.00 431.90 25.81

1 8       2 yr 1351.00 431.85 6.06
1 8       10 yr 2365.00 433.57 7.76
1 8       25 yr 2775.00 434.16 8.21
1 8       50 yr 3042.00 434.51 8.47
1 8       100 yr 3279.00 434.81 8.69
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HEC-RAS  Plan: Plan 01   River: Mill River   Reach: 1 (Continued)
Reach River Sta Profile Q Total W.S. Elev Vel Chnl

(cfs) (ft) (ft/s)
1 7       2 yr 1351.00 431.75 5.41
1 7       10 yr 2365.00 433.48 6.98
1 7       25 yr 2775.00 434.06 7.44
1 7       50 yr 3042.00 434.42 7.71
1 7       100 yr 3279.00 434.71 7.94

1 6       2 yr 1351.00 431.58 2.16
1 6       10 yr 2365.00 433.26 3.09
1 6       25 yr 2775.00 433.82 3.41
1 6       50 yr 3042.00 434.15 3.62
1 6       100 yr 3279.00 434.44 3.79

1 5.5     Inl Struct

1 5       2 yr 1351.00 424.48 4.21
1 5       10 yr 2365.00 425.65 4.57
1 5       25 yr 2775.00 426.11 4.67
1 5       50 yr 3042.00 426.41 4.72
1 5       100 yr 3279.00 426.67 4.76

1 4       2 yr 1351.00 420.90 7.76
1 4       10 yr 2365.00 422.12 9.81
1 4       25 yr 2775.00 422.53 10.52
1 4       50 yr 3042.00 422.78 10.95
1 4       100 yr 3279.00 423.00 11.30

1 3       2 yr 1351.00 419.14 8.04
1 3       10 yr 2365.00 420.41 9.77
1 3       25 yr 2775.00 420.86 10.32
1 3       50 yr 3042.00 421.14 10.65
1 3       100 yr 3279.00 421.40 10.89

1 2       2 yr 1351.00 419.10 7.58
1 2       10 yr 2365.00 420.36 9.27
1 2       25 yr 2775.00 420.80 9.83
1 2       50 yr 3042.00 421.06 10.18
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HEC-RAS  Plan: Plan 01   River: Mill River   Reach: 1 (Continued)
Reach River Sta Profile Q Total W.S. Elev Vel Chnl

(cfs) (ft) (ft/s)
1 2       100 yr 3279.00 421.31 10.45

1 1       2 yr 1351.00 418.41 9.25
1 1       10 yr 2365.00 419.60 11.07
1 1       25 yr 2775.00 420.01 11.71
1 1       50 yr 3042.00 420.29 12.04
1 1       100 yr 3279.00 420.51 12.35

1 0       2 yr 1351.00 416.69 9.69
1 0       10 yr 2365.00 417.68 12.16
1 0       25 yr 2775.00 418.05 12.90
1 0       50 yr 3042.00 418.27 13.38
1 0       100 yr 3279.00 418.47 13.75
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Appendix 12: Alternatives Research 
 

This appendix summarizes the external literature review of alternatives, with visualizations 
accompanying each description. We conducted research on live crib walls, retaining walls, 
stream barbs, live staking, live siltation, brush layers, riprap, fabric encapsulated lifts, live 

fascines, and wattle fences. 
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Live Crib Wall: “Live crib walls are constructed with interlocking, untreated logs and live 
stems. The logs are anchored into the slope, forming the wall, and vegetation is initially used to 
tie the logs together. Long-term stability to the slope is further developed with the vegetation’s 
root growth. With time, the logs naturally degrade and the vegetation becomes the structure 
itself.” (Ohio Dept. of Natural Resources, 2010) 

 

Figure 12-1. Visualization of Live Crib Wall 
(http://www.timmessick.com/illustrations/h2a29ab0e#h2a29ab0e) 

 
Retaining Wall:  
Types of Retaining Walls (U.S. Army Corps of Engineers, 1989): 

• Gravity 
o Rely on the weight of the wall system to resist overturning 
o Materials 

§ Concrete or stone masonry 
§ Can use steel to minimize size of wall sections 

o Disadvantages 
§ Not economical for high walls (but maybe in our case since the greenway 

will be adding weight for stabilization and the river will provide lateral 
forces) 

• Cantilever 
o Fully reinforced to resist applied moments and shears 
o Special type of gravity wall in which part of the stabilizing weight is supplied by 

the weight of the backfill resting on the base slab 
o Economical up to a height of 8m 
o Materials 

§ Reinforced Concrete 
§ Steel reinforcement bars 
§ Most economical type of conventional wall for common heights 

• Anchored  
o Resist lateral forces primarily by the use of tieback anchors 
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o Advantages 
§ Known for reliability, longevity, and economy 
§ Can be installed at any inclination through all types of overburden and 

rock 
o Disadvantages  

§ In fine-grained soils, effective groundwater discharge systems may be 
difficult to construct and to maintain 

§ Nearby construction may change soils stresses, decreasing tieback 
capacity possibly leading to failure. 

• Mechanically stabilized backfill 
o Involves the inclusion of the reinforcement in the soil to form a coherent mass 
o Can be used in combination with geotextiles 
o Materials 

§ Primarily soil 
§ Performance improved by small quantities of other materials in the form 

of strips, grids, sheets, rods, or fibers. Resist tensile forces that soil alone 
is unable to withstand. 

o Advantages 
§ Economical compared to conventional retaining walls 
§ Construction is usually easy and rapid - does not require skilled labor or 

specialized equipment 
§ Capable of withstanding dynamic loads imposed by wave action, wheel 

loads, and impact of small boats 
§ Stable under chemical and biological conditions normally occurring in 

soils 
§ More aesthetically pleasing 

o Disadvantages 
§ Corrosion of metallic reinforcement occurs and must be assessed on a 

project basis by determining the potential aggressiveness of the soil 
§ Requires wider excavation than conventional retaining walls 
§ Excavation behind the wall is restricted 

• Gravity and cantilever walls are most common, usually constructed of cast-in-place 
concrete 

 
Of the many types of retaining wall, we would use concrete Cantilevered wall, as they are the 
most aesthetically pleasing for its price, and one of the most commonly used walls. 

 
Based on research we were hoping to use a Mechanically Stabilized Earth Wall, but our liaison, 
Jim Hyslip, provided the following reasoning for why this would not be an appropriate solution 
in our case:  

“A MSE wall would be a good alternative if there was a good way to armor the face to 
provide ‘hardened’ infrastructure to allow the road/greenway and the river to happily 
coexist for a very long time.  Once you’ve designed a robust face for the MSE wall, then 
you’re probably getting close to a mass gravity structure that doesn’t need reinforcement. 
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Also, for an MSE wall, the lowest tensile grid is always the longest, and quick rule-of-
thumb is the bottom grid is around 75% to 100% of the height of a wall.  So a 12 ft high 
wall would need a bottom flat space behind the wall of at least 12 feet, to allow 
placement of the bottom grid.  At our site, I think that would put the excavation for the 
new wall underneath the existing roadway.”  
(Email from Jim Hyslip 3/13/18) 

 

        
Figure 12-2. River Retaining Wall 

(https://howardsykes.mycouncillor.org.uk/2016/08/18/duchess-street-pencil-brook-deteriorating-
retaining-wall/) 

 
Stream Barbs: “Stream barbs are low dikes or sill-like structures that extend from the bank 
towards the stream in an upstream direction. As flow passes over the sill of the stream barb, it 
accelerates, similar to flow over the weir of a drop structure, and discharges normal to the face of 
the weir. Thus, a portion of the stream flow is redirected in a direction perpendicular to the 
angled downstream edge of the weir. ” (USDA, 2013) 
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Figure 12-3. Stream Barbs  

(https://drainage.pca.state.mn.us/index.php?title=Stream_Barbs/J-hook_Vanes) 

 
Live Staking: “Live staking involves the insertion and tampering of live, rootable vegetative 
cuttings into the ground. If correctly prepared, handled and placed, the live stake will root and 
grow. A system of stakes creates a living root mat that stabilizes the soil by reinforcing and 
binding soil particles together and by extracting excess soil moisture.” (USDA , 2013) 

 

Figure 12-4. Live Staking Sketch (USDA, 2013) 
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Figure 12-5. Live Staking  

(https://www.cardnonativeplantnursery.com/about-the-nursery/nursery-notes/posts/nursery-
notes/2015/03/02/live-stakes-in-the-dead-of-winter) 

 
 
Live Siltation:  Live Siltation is a streambank vegetation method placed at normal high water 
level involving digging a trench for placement of live cuttings. This stabilizes the near-bottom 
slope of the bank, slowing down of the flow, and habitat. 

 
Figure 12-6. Live Siltation Sketch 

(http://www.adfg.alaska.gov/index.cfm?adfg=streambankprotection.siltation) 
 



12-7	
	

 
Figure 12-7. Live Siltation 

(http://www.adfg.alaska.gov/index.cfm?adfg=streambankprotection.siltation) 

Brush Layers: These are horizontally placed cuttings placed between layers of soil. The soil 
may or may not be encapsulated. Brush layers protect the bank from erosion and allow for. 

 
Figure 12-8. Brush Layers Sketch 

(http://www.adfg.alaska.gov/index.cfm?adfg=streambankprotection.layering) 
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Figure 12-9. Brush Layers  

(https://www.dec.ny.gov/docs/water_pdf/sec4.pdf) 

Riprap: Riprap is the layering of (typically angular) rocks along a threatened area to counteract 
the constant wearing away of land brought about by repetitive hydrologic activity. It is the 
traditional response to controlling and minimizing erosion along shorelines and riverbanks. 

 
Figure 12-10. Riprap  

(http://www.westconsultants.com/services/technology-and-software-development/riprap-design-
system/) 

Fabric Encapsulated Lifts: Soil layers are “encapsulated” inside of biodegradable fabric to 
form the lift. Each new course, or layer, of lift is placed on the preceding course but stepped back 
to create the desired slope. They are planted or seeded to long-rooted native plants that help to 
stabilize the soil layers. 
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Figure 12-11. Fabric Encapsulated Lifts  

(https://www.rachelcontracting.com/projects/handy-creek-bank-stabilization) 
 

Live Fascines: Live fascines are long bundles of live woody vegetation buried in a streambank 
parallel to the flow. The plant bundles sprout and develop roots that stabilizes the soil. 
 

 
Figure 12-12. Live Fascines Sketch  

(http://www.sotir.com/publications/brushing_erosion.html) 
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Figure 12-12. Live Fascines  

(http://www.bender-rekultivierungen.de/en/services/bioengineering/) 
 

Wattle Fences: These wood fences form miniature retaining walls that hold back soil in place to 
prevent erosion, and also protect against erosion caused by the stream. 

 

 
Figure 12-14. Wattle Fences  

(http://www.kennebecasisriver.ca/wattle.html) 
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Appendix 13: Design Verification for Hydraulic Model and Bank Protection Designs 

The following is documentation of the HEC-RAS model and bank protection fulfillment of the design 
requirements. The verification material is introduced as listed below. Note the verifications that are 

appendices are not featured in this document ensemble, since they are already within this report. 

Hydraulic Model Verification: 

HR-V-01 – Figure 13 from Final Report 

HR-V-02 – Figure 13 from Final Report 

HR-V-03 – Appendix 6: Accuracy Calculations for HEC-RAS Model 

HR-V-04 – Figure 14 from Final Report 

HR-V-05 – Hill Engineers Email Confirmation 

Recommended Bank Protection Design Verification: 

BP-V-01 – NCRS Technical Supplement 14I: Streambank Soil Bioengineering – Table TS14I–4 

& NRCS Part 654 Restoration Design National Engineering Handbook: 
 Chapter 8 Threshold Channel Design – Figure 8–25 

& HEC-RAS Alternatives Model Velocity Outputs (With and Without Dam) 

BP-V-02 – Same as above 

BP-V-03 – HEC-RAS Cross Sections 

BP-V-04 – Figure 15 from Final Report 



Hydraulic Model Verification



HR-V-01 & HR-V-02  

Figure 13 from Final Report 

 

Figure 13. Screenshot from HEC-RAS Showing Flows of the 2, 10, 25, 50, 100 year floods 

 



HR-V-04 – Figure 14 from Final Report 

Figure 14. HEC-RAS Screenshot Showing the Brassworks Dam Modeled as an Inline 

Structure 



Marcia Rojas <mrojas@smith.edu>

Survey Shadowing
Timothy Armstrong <tarmstrong@hillengineers.com> Mon, Mar 26, 2018 at 11:54 AM
To: Marcia Rojas <mrojas@smith.edu>

Marcia,

I’ve taken a look at the control information you provided, that was a nice presentation.  I have a few comments regarding the data from a surveyors perspective.  I do
not know what sort of accuracy you need between all the data points for your analysis, so this may not matter for you.  The Trimble GeoXH you used to collect the
coordinates on your control points is what we refer to as a sub-meter unit.  Due to the way it is calculating its position, it always had error in it that is in the 1’ to 2’
range.  It’s not so much that it is wrong , it’s that the data has uncertainty in it that prevents the point from being more precise.  You can see that in the coordinate
comparison on the USGS disk that we have both located (see below).  It all really depends on what the requirements are for the final application of the data.

306 (Hill
point) 2963922.605 330857.0334 427.37

MDSK
USGS+

Smith
(meters) 903406.27 100845.05 129.7

Smith
(USFT) 2963925.4 330855.8 425.52

Difference -2.795 1.2334 1.85

That is the amount of difference I expect to see between a sub-meter GPS point and out survey point.  Each of the control points will likely have this amount of error,
but not in a consistent direction.  This is strictly looking at the control points and does not take into account the total station data.  Any points located with the total
station from the same setup should be consistent together.  I also do not know how this may, or may not, affect your hydrology work.  Your advisor who processed
that data may have done some adjustment as well.  I’d be happy to look at all your data if you would like.

I would be happy to answer any additional questions you may have or you data as well.

Sincerely,

Tim

Tim Armstrong, PLS

Chief Land Surveyor

50 Depot Street

Dalton, MA 01226

413-684-0925  X148

fax 413-684-0267

www.hillengineersma.com

HR-V-05

https://maps.google.com/?q=50+Depot+Street+Dalton,+MA+01226&entry=gmail&source=g
https://maps.google.com/?q=50+Depot+Street+Dalton,+MA+01226&entry=gmail&source=g
http://www.hillengineersma.com/


Marcia Rojas <mrojas@smith.edu>

Bathymetry Data Control Points
1 message

Marcia Rojas <mrojas@smith.edu> Wed, Mar 14, 2018 at 4:06 PM
To: Tim Armstrong <tarmstrong@hillengineers.com>

Dear Tim,

Attached you will find the Site Visit 11 Summary PDF containing the information on the control points for our bathymetry data. 
Please let me know if you have any questions!

Best,
Marcia 

--  
Marcia Rojas 
Smith College '18
mrojas@smith.edu

Site Visit 11 Summary.pdf 
11392K

HR-V-05

mailto:mrojas@smith.edu
https://mail.google.com/mail/u/0/?ui=2&ik=9e884cbd62&view=att&th=162261f0ab25e31a&attid=0.1&disp=attd&realattid=f_jeriimm00&safe=1&zw


Bank Protection Design Verification



BP-V-01 & BP-V-02   

NCRS Technical Supplement 14I: Streambank Soil Bioengineering – Table TS14I–4  

 

NRCS Part 654 Restoration Design National Engineering Handbook:  
Chapter 8 Threshold Channel Design – Figure 8–25 

 



HEC-RAS  Plan: Plan 08   River: Mill River   Reach: 1

Reach River Sta Profile Q Total W.S. Elev Vel Chnl

(cfs) (ft) (ft/s)

1 13      2 yr 1351.00 447.37 6.37

1 13      10 yr 2365.00 447.97 7.37

1 13      25 yr 2775.00 448.16 7.72

1 13      50 yr 3042.00 448.34 7.73

1 13      100 yr 3279.00 448.57 7.45

1 12      2 yr 1351.00 442.85 11.58

1 12      10 yr 2365.00 444.28 11.96

1 12      25 yr 2775.00 444.92 11.81

1 12      50 yr 3042.00 445.29 11.82

1 12      100 yr 3279.00 445.52 12.12

1 11      2 yr 1351.00 436.96 14.34

1 11      10 yr 2365.00 437.67 17.31

1 11      25 yr 2775.00 437.88 18.59

1 11      50 yr 3042.00 438.02 19.24

1 11      100 yr 3279.00 438.16 19.60

1 10      2 yr 1351.00 437.15 9.29

1 10      10 yr 2365.00 438.37 11.12

1 10      25 yr 2775.00 438.79 11.75

1 10      50 yr 3042.00 439.06 12.13

1 10      100 yr 3279.00 439.31 12.38

1 9       2 yr 1351.00 430.06 20.48

1 9       10 yr 2365.00 430.89 22.22

1 9       25 yr 2775.00 431.19 22.76

1 9       50 yr 3042.00 431.38 23.09

1 9       100 yr 3279.00 431.55 23.38

1 8       2 yr 1351.00 431.85 5.98

1 8       10 yr 2365.00 433.52 7.88

1 8       25 yr 2775.00 434.07 8.53

1 8       50 yr 3042.00 434.39 8.94

1 8       100 yr 3279.00 434.67 9.28

1 7       2 yr 1351.00 431.75 5.23

1 7       10 yr 2365.00 433.48 6.81

1 7       25 yr 2775.00 434.04 7.35

1 7       50 yr 3042.00 434.38 7.68

1 7       100 yr 3279.00 434.67 7.97

1 6       2 yr 1351.00 431.58 2.16

1 6       10 yr 2365.00 433.26 3.09

1 6       25 yr 2775.00 433.82 3.41

1 6       50 yr 3042.00 434.15 3.62

1 6       100 yr 3279.00 434.44 3.79

1 5.5     Inl Struct

1 5       2 yr 1351.00 424.48 4.20
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HEC-RAS  Plan: Plan 08   River: Mill River   Reach: 1 (Continued)

Reach River Sta Profile Q Total W.S. Elev Vel Chnl

(cfs) (ft) (ft/s)

1 5       10 yr 2365.00 425.66 4.56

1 5       25 yr 2775.00 426.12 4.66

1 5       50 yr 3042.00 426.41 4.71

1 5       100 yr 3279.00 426.67 4.76

1 4       2 yr 1351.00 420.89 7.80

1 4       10 yr 2365.00 422.09 9.87

1 4       25 yr 2775.00 422.51 10.56

1 4       50 yr 3042.00 422.78 10.96

1 4       100 yr 3279.00 423.00 11.30

1 3       2 yr 1351.00 419.18 7.93

1 3       10 yr 2365.00 420.51 9.53

1 3       25 yr 2775.00 421.01 9.99

1 3       50 yr 3042.00 421.33 10.24

1 3       100 yr 3279.00 421.62 10.43

1 2       2 yr 1351.00 419.10 7.89

1 2       10 yr 2365.00 420.41 9.67

1 2       25 yr 2775.00 420.91 10.19

1 2       50 yr 3042.00 421.20 10.54

1 2       100 yr 3279.00 421.47 10.81

1 1       2 yr 1351.00 418.42 9.30

1 1       10 yr 2365.00 419.62 11.17

1 1       25 yr 2775.00 420.03 11.82

1 1       50 yr 3042.00 420.31 12.15

1 1       100 yr 3279.00 420.54 12.47

1 0       2 yr 1351.00 416.67 9.74

1 0       10 yr 2365.00 417.64 12.30

1 0       25 yr 2775.00 418.00 13.06

1 0       50 yr 3042.00 418.21 13.56

1 0       100 yr 3279.00 418.41 13.91
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HEC-RAS  Plan: Plan 07   River: Mill River   Reach: 1

Reach River Sta Profile Q Total W.S. Elev Vel Chnl

(cfs) (ft) (ft/s)

1 13      2 yr 1351.00 447.37 6.37

1 13      10 yr 2365.00 447.97 7.37

1 13      25 yr 2775.00 448.16 7.72

1 13      50 yr 3042.00 448.34 7.73

1 13      100 yr 3279.00 448.57 7.45

1 12      2 yr 1351.00 442.85 11.58

1 12      10 yr 2365.00 444.28 11.96

1 12      25 yr 2775.00 444.92 11.81

1 12      50 yr 3042.00 445.29 11.82

1 12      100 yr 3279.00 445.52 12.12

1 11      2 yr 1351.00 436.96 14.34

1 11      10 yr 2365.00 437.67 17.31

1 11      25 yr 2775.00 437.88 18.59

1 11      50 yr 3042.00 438.02 19.24

1 11      100 yr 3279.00 438.16 19.60

1 10      2 yr 1351.00 437.15 9.29

1 10      10 yr 2365.00 438.37 11.12

1 10      25 yr 2775.00 438.79 11.75

1 10      50 yr 3042.00 439.06 12.13

1 10      100 yr 3279.00 439.31 12.38

1 9       2 yr 1351.00 430.06 20.48

1 9       10 yr 2365.00 430.89 22.22

1 9       25 yr 2775.00 431.19 22.76

1 9       50 yr 3042.00 431.38 23.09

1 9       100 yr 3279.00 431.55 23.38

1 8       2 yr 1351.00 431.80 6.03

1 8       10 yr 2365.00 433.33 8.12

1 8       25 yr 2775.00 433.83 8.83

1 8       50 yr 3042.00 434.13 9.27

1 8       100 yr 3279.00 434.39 9.64

1 7       2 yr 1351.00 431.70 5.29

1 7       10 yr 2365.00 433.27 7.03

1 7       25 yr 2775.00 433.79 7.62

1 7       50 yr 3042.00 434.11 7.99

1 7       100 yr 3279.00 434.37 8.29

1 6       2 yr 1351.00 426.04 8.14

1 6       10 yr 2365.00 426.96 9.80

1 6       25 yr 2775.00 427.30 10.33

1 6       50 yr 3042.00 427.50 10.65

1 6       100 yr 3279.00 427.68 10.92

1 5       2 yr 1351.00 422.94 14.60

1 5       10 yr 2365.00 423.34 16.83

1 5       25 yr 2775.00 423.45 17.65
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HEC-RAS  Plan: Plan 07   River: Mill River   Reach: 1 (Continued)

Reach River Sta Profile Q Total W.S. Elev Vel Chnl

(cfs) (ft) (ft/s)

1 5       50 yr 3042.00 423.52 18.10

1 5       100 yr 3279.00 423.59 18.49

1 4       2 yr 1351.00 420.89 7.80

1 4       10 yr 2365.00 422.09 9.87

1 4       25 yr 2775.00 422.51 10.56

1 4       50 yr 3042.00 422.78 10.96

1 4       100 yr 3279.00 423.00 11.30

1 3       2 yr 1351.00 419.18 7.93

1 3       10 yr 2365.00 420.51 9.53

1 3       25 yr 2775.00 421.01 9.99

1 3       50 yr 3042.00 421.33 10.24

1 3       100 yr 3279.00 421.62 10.43

1 2       2 yr 1351.00 419.10 7.89

1 2       10 yr 2365.00 420.41 9.67

1 2       25 yr 2775.00 420.91 10.19

1 2       50 yr 3042.00 421.20 10.54

1 2       100 yr 3279.00 421.47 10.81

1 1       2 yr 1351.00 418.42 9.30

1 1       10 yr 2365.00 419.62 11.17

1 1       25 yr 2775.00 420.03 11.82

1 1       50 yr 3042.00 420.31 12.15

1 1       100 yr 3279.00 420.54 12.47

1 0       2 yr 1351.00 416.67 9.74

1 0       10 yr 2365.00 417.64 12.30

1 0       25 yr 2775.00 418.00 13.06

1 0       50 yr 3042.00 418.21 13.56

1 0       100 yr 3279.00 418.41 13.91

BP-V-02



100-Year Flood Bank Protection Design with Dam
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100-Year Flood Bank Protection Design without Dam
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BP-V-04 – Figure 15 from Final Report 

 

Figure 15. A 17ft Road Extension Intrudes a Total Distance of 10.24ft into the River at XS7 

(Top) and the Riverbed is Shifted 10.24 away from Route 9 (Bottom) 

 

 



Appendix 14: Calibrating Manning’s Roughness Coefficient to 
Account for Bend Head Losses 

Following method documented in “Accuracy Of HEC-RAS To Calculate Flow Depths And Total Energy 
Loss With And Without Bendway Weirs In A Meander Bend (2005)” 

 
 

The following method was developed by the Engineering Research Center at Colorado State 
University for the Internal Bureau of Reclamation. It aims at adjusting Manning’s Roughness 

coefficient in HEC-RAS to account for the energy losses in meander bends  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



 
 
 
Prepared by: Maya Sleiman 
For: WMRGC DC Project  
Last Updated: 03/27/18 
 
 
Background 
HEC-RAS contains built-in tools that account for two sources of head loss: friction (through 
Manning’s roughness coefficient ), and expansion/contraction (through coefficients ofn  
expansion and contraction at each cross-section). 
Bends, however, undergo additional head losses due to secondary currents in the flow. With no 
tools to account for these losses, HEC-RAS underestimates the total head loss in bends.  
This method adjusts manning’s roughness ( ) to account for additional bend-related losses.n   
 
 
Conclusion 
Using the method below, it was determined that the 0.035 initial guess for channel roughness 
was an overestimation at XS11 and XS10 (two of the four bend cross sections), but a good 
estimation for XS12 and XS9.  
 
It was thus decided that it would be best to perform the model calibration based on the W.S. 
Level values measured by Brett Towler at different flows.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 



List of Symbols and Abbreviations 
ead loss due to f riction (f t)   hf = h  

 head loss due to bend (f t)   hbend =   
total head loss (f t) hT =   
adius of  curvature (f t) rc = r  
f riction slope slope of  the energy grade line dH/dL (f t/f t), where H  is total headSf =  =  =    

f riction slope calculated using one of  Manning s equations (f t/f t)SfManning =  ′  
W  Top Width (f t) T =   
x ownstream reach distanceΔ = d  

 
Premise of procedure 
It was empirically determine that there exists a strong correlation between the ratio /hhBEND f  
and a dimensionless parameter equal to the ratio  through the following equation:π5 W /rT c  

                                ​     ( Eqn. 14-1)/h 4.0ehBEND f =  (−0.45π5)  
 
 
 
Procedure 

1. Use a map to approximate the radius of curvature of the bend .rc   
2. Use HEC-RAS’s output table to find of each cross sectionW  T   
3. Using the average and of the bend, is calculated using the following equation:WT rc 5π  

  W /rπ5 = T c   ( Eqn. 14-2) 
 

4. Using the calculated term, the ratio  is calculated using the following5 π /hhf  Bend  
empirically derived relationship: 

/h 4.0ehBend f =  (−0.45π5)  ( Eqn. 14-3) 
   

5. Using the calculated ratio and  values output by HEC-RAS,  is/hhf  Bend hf hBend  
calculated using the following equation: 

h /h )hBend = ( Bend f * hf  ( Eqn. 14-4) 
6. Total head loss is then calculated by definition as follows: 

hT = hBend + hf  ( Eqn. 14-5) 
7. The friction slope is calculated by definition as follows:Sf  

)/ΔxSf i = (hi − hi+1  ( Eqn. 14-6) 
8. The friction slope is calculated using HEC-RAS’s manning’s roughness asSfManning  

follows: 
/ϕAR )SfManning = (nQ2 2/3 2  ( Eqn. 14-7) 

 

 



9. Use the Solver Excel Add-in to minimize the difference between and bySf SfManning  
changing n.  

 
 
II. Manning’s Calibration for our Model 
 

1. A snapshot from Google Maps of the Bend was imported into AutoCAD (Fig.14-1a) and 
a circle was approximately fitted to the bend curve.  The center of the circle was located. 
The real distance between the center of the circle to the edge was found to be 380ft 
using the measure tool in Google Maps. (Fig. 14-1ba) 

 
 
 

a 

b 
Figure 14-1.​  (a, above) is a screenshot from AutoCAD showing a circle fitted to the bend curve. 
Google Maps measuring tool was used to measure the distance from the located center to the 
curve edge (b, below).  

 



 
2. The Top Width of the each bend cross section was imported from HEC-RAS Output 

Table 
 

 
 

3. The above values were averaged out in Excel, and used with to calculate .W  T rc 5π  

 

 



4. The friction loss is imported from HEC-RAS (left), and the ratio washf  /hhBEND f  
calculated using .5π  

 
5. The ratio is calculated using , and is calculated using the ratio./hhBEND f 5π hBEND   

 
 

 



6. Total loss is calculated by summing the columns and .ht hBend hf   

 
 
 

7. The downstream reach length is imported from HEC-RAS and used to calculate the 
friction slope.  

 
 

8. Flow (Q), Flow area (A), Hydraulic Radius (R ), and HEC-RAS’s Manning’s roughness 
coefficient are used to calculate .SfManning s′  

 

 



9.  Excel’s Solver Add-in was used to minimize the square difference between andSf  
for each of the cross sections by adjusting n.SfManning   
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Appendix 15: Gantt Chart 

This Gantt Chart represents the timeline of our project. 



MRGC Gantt Chart 
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